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Chapter 1 Overview

1-1 Chapter Outline

The BAE-VX1000 Multi Codec HD-Video Encoder System 
(hereafter referred to as “encoder system”), is a software 
encoding system that you can use to create H.264/AVC or 
MPEG-2 primary and secondary video ES, menu 
background, and slideshow’s still image ES, which are 
suitable for the BD-ROM and DVD formats.
Also, the software decoder of generated primary and 
secondary videos is included.
The encoder system provides the following features.

BD-ROM
Compression method: H.264/AVC and MPEG-2

AVC: High Profile, Main Profile

Level 3, 3.1, 3.2, 4, 4.1

MPEG-2: MP@HL, MP@14HL, 

MP@ML

Frame rate: 23.976p, 24p, 25i, 25p*, 29.97i, 

29.97p*, 50p, 59.94p

Aspect ratio: 16:9 or 4:3

Resolution: HD: 1920 × 1080, 1440 × 1080 

(59.94i, 50i, 24p, 23.976p) 

1280 × 720

(59.94p, 50p, 24p, 23.976p) 

SD: 720 × 480 

(59.94i, 29.97p*, 24p*, 

23.976p*) 

720 × 576 (50i, 25p*) 

*  Secondary video only

Maximum bit rate: 40 Mbps

DVD
Compression method: MPEG-2: MP@ML

Frame rate: 25i, 25p, 29.97i, 29.97p

Aspect ratio: 16:9 or 4:3

Resolution: 720 × 480 (59.94i)

720 × 576 (50i)

352 × 240 (29.97p)

352 × 288 (25p)

352 × 480 (59.94i)

352 × 576 (50i)

704 × 480 (59.94i)

704 × 576 (50i)

Maximum bit rate: 9.8 Mbps

1-1-1 Features of BAE-VX1000

Distributed processing

Depending on the user requirements and size of system, the 
encoder system can support a simple system consisting of 
just one computer, or a distributed system deploying a large 
number of PCs to enable real time encoding. Such design 
makes it possible to build a scalable system.
Scene change detection of title for distributed encoding and 
pulldown pattern detection of telecine title are handled 
during title capture or on the Preprocess screen. Because a 
pre-process operation can be performed on another PC, it is 
possible to pre-process the next title in parallel without 
having to wait for this encoding process to finish. The AVC 
encoder system references the scene change detected by the 
pre-process operation, and then distributes files 
automatically for processing on multiple PCs used for 
encoding. For this reason, the overall encoding time can be 
shortened. AVC or MPEG-2 Video ES files generated by 
distributed processing are combined into one file during the 
Finalize process.

One-pass encoding 

The one-pass encoding sequence allows the encoding 
process to complete within the shortest time. In general, the 
one-pass encoding sequence is inferior to the two-pass 
encoding sequence in terms of picture quality. The one-pass 
encoding sequence is effective when the title is short relative 
to the disk and encoding can be done using high bit rate, or 
when changes in the pictures are so small that sufficient 
picture quality can be expected even at low bit rate. 
Depending on the picture content, you can use the 1 Pass 
VBR that can change the bit rate assignment in units of GOP, 
or the 1 Pass CBR where the same bit rate is used throughout 
the entire title.

Two-pass encoding

When judged by the bit rate assignment, the two-pass 
encoding sequence is a method that enables the encoding 
process to proceed in an ideal manner. Based on the result of 
the first pass of encoding, this function performs bit rate 
assignment according to the coding difficulty, and then 
performs the second pass of encoding. Therefore, while it 
takes at least twice the time of the length of a title, this 
method produces the best balance in bit rate assignment for 
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all pictures on the disk, so that high picture quality encoding 
can be possible.

Fast two-pass encoding

In normal two-pass encoding, during temporary encoding in 
the first pass, level of difficulty is measured and picture type 
is decided for all pictures. While this method enables best bit 
assignment for the level of difficulty of the title, encoding 
takes twice the amount of time.
Fast two-pass encoding can shorten the time required to 
complete encoding in the second pass, by performing a 
checking process using an original feature extraction 
algorithm.

Partial encoding

While the bit rate assignment algorithm in two-pass 
encoding gives sufficiently high picture quality, depending 
on the difficulty of the title, there may be segments that 
require modification after encoding. In this case, you can use 
the partial encoding function. After encoding, you can select 
just the segment where picture quality adjustment is 
necessary, change the picture quality parameters, or adjust 
the bit rate assignment (using Customize). After the 
customization, you can encode just the smallest range 
required for reencoding. Because reencoding of the entire 
title is not required, this enables you to get the best picture 
quality in an efficient way.

Title substitution

If you need to modify the source file after encoding is 
finished, you can use the modified source file and then 
encode again but only using the specified range.

Notes
• If the source file has been significantly modified, optimal 

picture quality may not be obtained.

• This feature is not compatible with fast two-pass 

encoding.

Automatic customization function

This function uses the distortion value (difference between 
the original picture quality and the new one) measured 
during the first pass of encoding as a basis, automatically 
detects parts of the picture that are difficult to encode, and 
then uses the several candidate bit rates set up in advance to 
perform multiple encoding. When two-pass encoding of the 

entire title is finished. You can review the multiple 
candidates and then select the most suitable one based on 
their picture quality and disk amount. With this function, you 
can use customization to shorten the reencoding time.

Review function

You can decode the encoding result’s stream file at real time 
and monitor it.
Playback at variable speeds (from 0.1 to 1× speed) in the 
normal direction and reverse direction step playback are 
possible, or you can jump to a specified position.
Also, you can speedily jump to a scene by dragging the slide 
bar, thus allowing you to easily search for a scene you want 
to jump to.

Customization

After encoding, you can customize the video using the 
following parameters.
Common: Weight control (Weight Adjust)

Specifying picture type (Picture Type)
Setting scene change detection (Scene 
Change)
Setting the low pass filter (Low Pass Filter)
Setting the noise removal filter (De-Noise 
Filter)
Setting the banding removal filter (De-
Band Filter)
Specifying the progressive mode 
(Progressive)

H.264/AVC: Changing the DCT size selection method 
(DCT Size)
Changing the scaling list (Scaling List)
Changing the deblocking filter 
(Deblocking Filter)
Changing the gradation improvement 
(Gradation Improvement)
Changing the macro block rate control 
(Macro Block Rate Control)
Changing the refreshing suppress 
(Refreshing Suppress)
Changing the trailing suppress (Trailing 
Suppress)

MPEG-2: Changing the QMatrix (QMatrix)

For details, refer to “6-3 Customization Review,” page 
63.
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Inverse telecine function

When encoding a title that has been processed by 2-3 
pulldown (telecine) conversion, you can improve the 
encoding efficiency by using the inverse 2-3 pulldown 
conversion to return the frame sequence back to the 24 
frames/second format. The pulldown pattern can be detected 
automatically during the pre-process operation performed 
before the encoding process. Alternatively, if a pulldown 
pattern already exists, its pattern information can be 
imported. The pulldown pattern detected automatically can 
be edited after the detection. By separating 2-3 pulldown 
title and normal video title into separate video blocks, you 
can encode titles containing a mix of pulldown and 
interlaced pictures. After this encoding, if you want to 
change the pulldown pattern, you need to start over again 
from the pre-process operation.

Note
The following three formats are supported.

• 1920 × 1080/59.94i

• 1440 × 1080/59.94i

• 720 × 480/59.94i

Automatic scene change detection

The AVC encoder system can automatically detect scene 
change in a title. It performs the most suitable encoding 
process by assigning picture type according to the scene 
change points. With this function, you can obtain high 
picture quality at a scene change. 

Processing time calculation

When you are creating a project, you can use parameters 
such as picture type, average bit rate, and capacity to 
calculate the approximate time required for encoding.

Batch processing function

You can register multiple projects, and encode them 
continuously.

Seamless multi-angle support

The encoder system supports BD-ROM and DVD format 
multi-angle, allowing seamless multi-angle encoding.

Closed caption support

You can insert BD-ROM and DVD format closed caption in 
encoded video ES files.

Notes
• It is not possible to directly extract closed caption data 

already multiplexed on the 21st line of the input video data 

and then multiplex it.

• For the DVD format, closed caption can be inserted only 

in the 2 Pass VBR mode.

Video capture

When you use the recommended video card, you can capture 
video and audio from a professional VTR or Handycam.
The scene change and telecine pattern detection that is 
necessary before encoding can be performed simultaneously 
during video capture.
By using Batch mode, you can capture multiple intervals of 
video and audio data consecutively.
By using Easy Encode mode, you can perform the capture 
and encoding processes in single operation.

Low pass filter

You can apply a low pass filter while encoding a source. You 
can select from three strength levels for the filter in each 
mode.

De-noise filter

You can apply a noise removal filter while encoding a 
source. You can select from three strength levels for the filter 
in each mode. Use this filter when encoding sources that 
contain video camera noise, for example.

De-band filter

You can apply a banding removal filter while encoding a 
source. You can select from two strength levels for the filter 
in each mode. Use this filter when encoding sources in which 
banding occurs.

Note
When the filter is applied while encoding at high bit rates, 
some textures in the source may be lost. We recommend 
using the filter with low bit rates (10 Mbps or below for HD 
encoding with AVC codec).

z Hint

For the best encoding results, we recommend applying 
this filter only to the sections where banding occurs.
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1-1-2 Differences Between Two-Pass 
Encoding and One-Pass Encoding

The encode software features two sequences: a high-quality 
two-pass encoding sequence and a fast one-pass encoding 
sequence. The basic flow of each sequence is described 
below.

Two-pass encoding sequence

Based on the result of the one-pass encoding sequence, the 
two-pass encoding sequence measures the coding difficulty, 
calculates the bit rate assignment according to the coding 
difficulty, and then runs encoding. Because bit rate 
assignment determined according to the scene can be spread 
across the entire title, this improves the picture quality.

Two-pass encoding sequence

Start 

Basic settings of 
encoding

Reviewing

End?

Post-processing

End

Project

Source

Configuration

Size

Select 
2 Pass VBR.

Review

Project

Encode 

Review 

UNDO 

Encode
1st pass

↓
2nd pass

Advanced settings 
of encoding

Yes

No

Customize

Customize

Reencode

DONE 
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One-pass encoding sequence

Because the one-pass encoding sequence requires only one 
encoding process, it is faster than the two-pass encoding 
sequence. In general, the one-pass encoding sequence is 
inferior to the two-pass encoding sequence in terms of 
picture quality. The one-pass encoding sequence is effective 
when the title is short relative to the disk capacity, and 

encoding can be done using a high bit rate, or when changes 
in the pictures are so small that sufficient picture quality can 
be expected even if the bit rate is low. You can select to use 
1 Pass CBR to encode using constant bit rate, or 1 Pass VBR 
to encode at a bit rate that varies according to the picture.

One-pass encoding sequence

Start 

Basic settings of 
encoding

Reviewing

End?

Post-processing

End

Project

Source

Configuration

Size

1 Pass CBR 
or Select 
1 Pass VBR

Review

Project

Encode 

Review 

UNDO 

Encode
1st pass

Advanced settings 
of encoding

Yes

No

Customize

Customize

Reencode

DONE 

For 1 Pass VBR only
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1-1-3 Supported Data Format

Input formats
Video:AVI file and QuickTime file formats

HD

• 1920 × 1080/59.94i, 50i, 24p, 23.976p

• 1440 × 1080/59.94i, 50i, 24p, 23.976p

• 1280 × 720/59.94p, 50p, 24p, 23.976p

SD

• 720 × 480/59.94i, 29.97p*, 24p*, 23.976p*

• 720 × 486/59.94i, 29.97p*, 24p*, 23.976p*

• 720 × 576/50i, 25p*

*Secondary video only

Notes

• To use 720 × 486 AVI files, you need to set up the 

cropping offset in Vinf Creator.

• If images cropped to the 720 × 480 size are sent via 

SDI and then displayed on a master monitor for 

review, the display position may become different.

Still image: TIF, JPEG, PNG, BMP, and GIF formats
• 1920 × 1080

• 1440 × 1080

• 1280 × 720

• 720 × 480

• 720 × 576

Capture format
YUV 4:2:2 10bit or 8bit AVI file

SDI

HD: 1920 × 1080 (59.94i, 50i, 24p, 23.976p)

1280 × 720 (59.94p, 50p)

SD: 720 × 486 (59.94i)

720 × 576 (50i)

HDMI

HD: 1920 × 1080 (59.94i)

SD: 720 × 486 (59.94i)

Conditions of title
Maximum size

The maximum size of an AVI file input into the AVC 
encoder system is 2 TB.*

* An AVI file using title of HD/60i/4:2:2 format takes up 
about 550 GB of capacity for each hour of the title length. 
Therefore, a 2-TB AVI file takes about 3.5 hours.

Output data
H.264/AVC or MPEG-2 Byte Stream Format File

ES file of H.264/AVC or MPEG-2
Slideshow timing information file (SPI file)

This file contains timing information specified for time-
based slideshow. It is used in multiplexing.

Linear-PCM audio file
It is saved as an AVI file during video capture.

Note
When the BAE-VX1000 software is installed, data is added 
to the registry related to QuickTime. As a result, this 
software may conflict with other applications that use 
QuickTime.
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1-2 Overview of BAE-VX1000 System Configuration

Distributed System

Standalone System
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1-3 Encoding Work Flowchart

This system consists of the following seven subsystems.
• Capture video (Capture)

Capture video from a connected VTR, and create AVI 

files.

While capturing video, you can perform the preprocess 

operation at the same time.

• Source management (Source Manager)

Register a source file (AVI or QuickTime file) for 

encoding.

Source files for encoding must all be registered in source 

management.

• Source project management (Project Manager)

Perform encoding settings of registered source file.

Create projects using the source files.

• Job project management (Job Editor)

Register source file for each title to create, and perform 

encoding settings.

• Preprocess

Detect scene change (available only in the case of 

distributed processing).

Detect pulldown pattern (mandatory in the case of inverse 

telecine).

• Encoder

Encode source file.

Review and customization of the encoding result is 

possible.

• Finalize

Integrate data to create a stream file.

The entire flow of this system is shown below.
For details on the operation procedure, refer to Chapter 2 and 
subsequent chapters.

Note
If Inverse 2-3 pulldown is selected in encoding of telecine 
titles, pulldown detection is required. If the pulldown 
process is not finished, the operation cannot proceed to the 
encoding process.
Scene change detection can be skipped; in this case, 
however, distributed encoding will not be performed.

z Hint

The AVI files you create can be converted to WAV files. 
To convert to WAV files, execute the AVI to WAV 
Converter command from the Tool menu of Launcher.

Note
Due to limitations for WAV files, you cannot create files that 
are 2 GB or larger with AVI to WAV Converter.
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2-1 Chapter Outline

This chapter describes how to start or quit Launcher, and set 
up the system environment. Launcher is used to provide the 
various functions of this system.

This chapter contains the following main contents.
• Starting and quitting Launcher

• Setting up the system environment

• Setting up the encoder PC

2-2 Starting and Quitting 
Launcher

2-2-1 Starting Launcher
Double-click the  BAE-VX1000 icon on the Desktop. 
Alternatively, point to [All Programs] from the Start menu, 
select [BAE-VX1000], and then select [BAE-VX1000].
Launcher starts.

When starting this software for the first time after 
installation, the System Setup Wizard dialog box appears.

For details on the System Setup Wizard, refer to “2-5 System 
Setup Wizard Settings,” page 21.

2-2-2 Quitting Launcher
Click the  button on the window, or select Exit from the 
File Menu.

2-2-3 Launcher Screen

Title block

a Menu bar
b Tool bar

c Title block
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Tool block

a Menu bar

b Tool bar

Display the Encode, Capture, and Source buttons.

Display the Project Monitor, Slide Show, Disc Image 
Creator, and Result View buttons.

c Title block

Encode button
Start Project Manager to create projects and register/run 
encoding.

Capture button
Open the Capture Control window to perform capture from 
VTR.

Source button
Start Source Manager to register source files.

d Tool block

Project Monitor button
Start Project Monitor to monitor encoding execution status.

For details on Project Monitor, refer to “6-2-6 Monitoring 
Encoding (Project Monitor Screen),” page 62.

Slide Show button
Start Slide Show Encoder to register or run jobs for still 
image encoding.

Disc Image Creator button
Open the Disc Image Creator window to multiplex imported 
Linear PCM audio data, and create BD-ROM disc images.

Result View button
Open the Result View window to display and compare the 
source image and encoded image on the same screen.

2-2-4 AVI to WAV Converter
When reusing audio data imported at the same time as video 
capture, you can convert the data to WAV format files.

Menu bar Command Description

File Import Import system environment information 
specified in the System Setup window 
from a file.

Export Export system environment information 
specified in the System Setup window 
to a file.

Exit Exit this software.

Tool Project 
Monitor

Open the Project Monitor window to 
monitor encoding execution status.

Slide Show Start Slide Show Encoder to register or 
run jobs for still image encoding.

Disc Image 
Creator

Open the Disc Image Creator window 
to multiplex imported Linear PCM 
audio data, and create BD-ROM disc 
images.

Result View Open the Result View window.

AVI to WAV 
Converter

Convert AVI files to WAV format.

System Setup 
Wizard

Open the System Setup Wizard.
For details, refer to “2-5 System Setup 
Wizard Settings,” page 21.

System Encoder PC 
Information

Display the Encoder PC Information 
window.
For details, refer to “2-4 Setting Up the 
Encoder PC,” page 19.

System Setup Display the System Setup window.
For details, refer to “2-3 Setting Up the 
System Environment,” page 16.

Help Version Display information on the software 
such as the current version and 
copyright information.

Error Lookup Enter an error code to display the 
content of an error.

d Tool block
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2-3 Setting Up the System 
Environment

To set up the system environment, click the System Setup 
button in Launcher.

2-3-1 Initializing the Settings File
When using this software for the first time after installation, 
be sure to initialize the settings file.

1 Click the System Setup button in the Launcher screen.

The System Setup window appears.

2 Click the Project tab.

3 Click the [Initialize] button.

A dialog box to browse folders appears.

4 Select a folder to store the settings file, and click the 
[OK] button.

The settings file is created in the folder specified.

2-3-2 System Setup Window (Folder 
Tab)

Input Folder block

Specify a pathname for storing input file. Select the radio 
box of the scene to set up, and then click the [Add] button to 
select a folder.

XML File (Movie)
Specify a pathname for storing XML files for video 
encoding.

XML File (Slide Show)
Specify a pathname for storing XML files for still image 
encoding.

Still image file
Specify a pathname for storing still images.

[Add] button
Add a path.

[Edit] button
Edit a pathname that has been set up.

[Delete] button
Delete a pathname that has been set up.

Output Folder block

Stream file
Specify the pathname of a destination for storing stream 
data. Enter a pathname, or click the Browse button to select 
a destination.

Project Data File
Specify the pathname of a destination for storing project data 
file. Enter a pathname, or click the Browse button to select a 
destination.

Capture File
Specify the pathname of a destination for storing captured 
file. Enter a pathname, or click the Browse button to select a 
destination.

Source Information File
Specify the pathname of a destination for storing source 
information file. Enter a pathname, or click the Browse 
button to select a destination.

Result View File
Specify the pathname of a destination for storing AVI files 
that will be displayed for comparison in Result View. Enter 
a pathname, or click the Browse button to select a 
destination.



2-3 Setting Up the System Environment 17

C
h

ap
ter 2

2-3-3 System Setup Window (Project 
Tab)

Setting Filename block

Source List
Specify the default source list file name. Enter a file name, 
or click the Browse button to select a file.

Job List
Specify the default job list file name. Enter a file name, or 
click the Browse button to select a file.

Preprocess Job List
Specify the job list file name of the default preprocess. Enter 
a file name, or click the Browse button to select a file.

Slide Show Job List
Specify the job list file name of the default slideshow. Enter 
a file name, or click the Browse button to select a file.

Default User Scaling List
Specify the default user’s specified scaling list file name. 
Enter a file name, or click the Browse button to select a file.

Default User QMatrix
Specify the default user’s specified QMatrix file name. Enter 
a file name, or click the Browse button to select a file.

[Initialize] button
Return the settings of the Setting Filename block to their 
defaults.

Default Set Size block

BDMV / DVD
Specify the default size of BDMV or DVD.

Customize Available Ratio
Specify the % of the size that can be used during 
customization.

Video Board Information block

Video Capture Board
Select a video output board to use.

Lustia block

Lustia Chroma
Select this to disable restriction of the passband for the 
video’s chroma data.

Lustia Darkness
Select this to disable restriction of the passband for the 
video’s luminance data.

Lustia Lightness
Select this to disable restriction of the passband for the 
video’s luminance data.

Lustia Black
Select the Lustia Darkness check box to enable Lustia Black 
configuration.
Select the Lustia Black check box to enable configuration of 
black level conversion for the video’s luminance data.

Masking 10bit Level
Configure the threshold of the luminance data for black level 
conversion.

Target 8bit Level
Configure the black level.
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Smart Luminance
Select this to reduce the effects of banding in videos.

[Reset] button
Return the settings of the Lustia block to their defaults.

Notes
• Use the Lustia Black and Smart Luminance settings at 

your discretion.

• If a Blackmagic Design Intensity card was used, you 

cannot confirm the output results of video data created in 

Lustia mode.

Setting Jumplist block

Specify customization items to display on the jump list.

[Reset] button
Return the settings of the Setting Jumplist block to their 
defaults.

z Hint

To back up a project, save the contents of the folders 
configured in the Folder tab and Project tab of the System 
Setup window.

2-3-4 System Setup Window (Mail Tab)

If you select this check box and then specify the parameters, 
an email message is sent when an error occurs or when 
encoding is finished normally.

Opportunity
Specify the opportunity for sending an email message.

Encode Error

Send an email message when an error occurs during 

encoding.

Encode Normal

Send an email message when encoding is finished 

normally.

Finalize
Send an email message when finalization is finished.

Use SMTP Authentication
If the STMP server you are using requires SMTP 
authentication, select this check box and configure account 
information.

Advanced block

Server Port Numbers (SMTP)
Configure this when not using the default port number to 
send email messages.

This server requires a secure connection (SSL)
Select this check box to transmit via the SMTP server and 
SSL.

[Use Defaults] button
Return setting information to defaults.

Attachment
Specify whether to attach the Event Log File created by the 
system as a file attachment.

[Test] button
If you click the [Test] button, the entered content is used in 
the email test transmission.

Note
Every time you click this button, an email message is sent.
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2-3-5 System Setup Window (Stream 
ID Generator Tab)

Use the respective settings file for each Video Type image 
size.

Bitmap File block

1920 × 1080 Video Type
Specify the default bitmap file name. Enter a file name, or 
click the Browse button to select a file.

1280 × 720 Video Type
Specify the default bitmap file name. Enter a file name, or 
click the Browse button to select a file.

720 × 480 Video Type
Specify the default bitmap file name. Enter a file name, or 
click the Browse button to select a file.

Notes
• Be sure to specify bitmap files that are RGB 24-bit format.

• There are no limits on file size.

• Image sizes are not converted according to resolution 

during loading.

Display Area block

Position
Specify the display position.

2-4 Setting Up the Encoder PC

To specify a PC for the encoding process, click the Encoder 
PC Information button in Launcher.

2-4-1 Registering Encoder PC

1 Click the [Add] button on the Encoder PC Information 
window.

The Setting Encoder PC window appears.

2 Enter the IP address or host name of the computer you 
want to register.

3 Enter the user name and password for logging in to the 
computer, and then click the [Connect] button.

Information on the CPU and memory of the computer 
to register is obtained.

4 Click the [OK] button to close the window.

z Hint

If these steps have been used to register a computer, 
Priority and Processes are automatically set up.

2-4-2 Encoder PC Information Window
Register a PC to run the encoding process. If you register 
multiple PCs, distributed processing is possible.

If you select this check box, PC registration is enabled and 
the encoding process is performed.

[Add] button
Display the Setting Encoder PC window.
Click this button if you want to add a host.
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[Edit] button
Display the Setting Encoder PC window.
Click this button if you want to edit the currently selected 
host.

[Delete] button
Delete the currently selected host.

[Analyze] button
Display the Setting Analysis of Encoding dialog box, and 
perform encoding as a test to find out the processing 
performance of the encoder PC. The priority of the encoders 
is determined from the execution result.

Setting Encoder PC dialog box

IP Address/Encoder PC
Select the IP Address or Encoder PC option button and then 
enter an IP address or host name accordingly.

User/Password/Confirm Password
Enter the user name, password, and confirmation password 
for logging in to the encoder PC. 
To log in using domain user name, enter using the “domain 
name\user name” format. To perform encoding using the 
computer displaying the Setting Encoder PC dialog box, do 
not enter the user name and password.

[Connect] button
The entered user name and password are used to connect to 
the encoder PC. When connection succeeds, information on 
the encoder PC is obtained and then displayed.

Processor Name
Display the processor name of the encoder PC.

Memory Size
The memory size of the encoder PC appears.

Processor
Display the processor number of the encoder PC.

Total Clock
Display the clock speed of the encoder PC.

[Update] button
Update the setting information of the encoder PC with the 
displayed content.

Priority
Specify the priority of processes between this encoder PC 
and other encoder PCs.

Processes
Specify the process number to perform encoding. If Auto is 
selected, the process number is determined from the 
obtained PC information.

Setting Analysis of Encoding dialog box

Source Filename
Specify a source file to encode. Enter a file name directly, or 
click the Browse button to select a file. 
You can specify a source file that is already registered in 
Source Manager.
If you want to raise the precision of the processing 
performance to obtain, we recommend that you select an HD 
source file.
DVD sources cannot be selected.

Temporary Pathname
Specify a working directory for encoding. Enter a directory 
name directly, or click the Browse button to select a 
directory. Specify a path that can be used by the encoder PC.

Duration
Specify the processing time of encoding. If you want to raise 
the precision of the processing performance to obtain, select 
a large value.

[OK] button
Perform the performance measurement.
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2-5 System Setup Wizard Settings

When starting this software for the first time after 
installation, the System Setup Wizard dialog box appears.

Perform system setup as follows.

1 Click the [Next] button.

If you want to perform setup later or use the setup of a 
previous version, click the [Cancel] button.

The Select Root Folder dialog box appears.

2 Specify the workplace root folder for BAE-VX1000, 
and click the [Next] button.

To change the root folder, click the [Browse] button and 
specify a root folder.

The Select Video Capture Board dialog box appears.

3 Select the video capture board from the pull-down 
menu, and click the [Next] button.

Setup is complete and the Ready to Setup dialog box 
appears.

4 Click the [Finish] button.

The configured settings are reflected in System Setup.

z Hint

If you canceled the wizard, you can configure settings by 
selecting System Setup from the System menu of the 
Launcher screen.
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3-1 Chapter Outline

This chapter describes a series of operations, from how to 
use the Launcher to start the Capture application, to how to 
perform capture.

This chapter contains the following main contents.
• Starting and exiting the Capture application
• Running Capture

3-2 Starting and Exiting Capture

3-2-1 Starting the Capture Application

1 Click the Capture button in Launcher.

A dialog box appears for you to specify a capture 
project file.

2 Specify a capture project file.

You can use the following methods to specify a capture 
setting file.
• Select it from files used before.

• Specify a file name, then open it.

• Create a new file.

For details, refer to “3-2-2 Specifying a Capture 
Project File,” page 23.

The Capture application window appears.
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3-2-2 Specifying a Capture Project File

a Menu bar

z Hint

You can configure the VTR detection mode using the 
VTR Type setting in the Capture Setup dialog box.
Auto Detection: Detect automatically
Sony SRW Series: Specify Sony SRW-series VTRs 
(SRW-5000, etc.)
Other Sony VTR: Specify other Sony VTRs
Other: Specify miscellaneous VTRs (D5, etc.)

b Select Used Capture Project File block

Select a file for current use, from capture project files used 
before.

c Open Capture Project File block

Specify the name of a capture project file and open the file.

File Name
Enter the pathname of a capture project file to use, or click 
the Browse button to select a capture project file.

[Open] button
Load the specified capture project file, and open the Capture 
Control window.

d Select New Capture Project File block

Create a new capture project file using the displayed 
settings.

Video Format
Select the format of a title to load.

Capture Video Bit Depth
Select number of bits used by YUV.

Audio Channel
Select audio channel.

Note

Audio data is fixed at 16 bits.

Preprocess Setting block
Configure settings for preprocessing during capture.

Field Order
Select the field order of the source file.

Cropping Lines
If the video format is 720 × 486, specify the number of lines 
to crop.

b Select Used Capture Project File block

c Open Capture Project File block

d Select New Capture Project File block

a Menu bar

Menu bar Command Description

File Close Close the dialog box.

Option Capture Setup Display the Capture Setup dialog box 
to set up capture. You can specify the 
default capture mode, VTR detection 
mode, preroll time, and offset frame 
number.

Help Version Display the version, copyright, and 
other information about this software.
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z Hint

• If the number of lines is set to 1, one line is cropped 
from the top of the screen, and five lines are cropped 
from the bottom.

• When capturing sources for DVD, select an odd 
number of lines.

[New] button
Create a capture project file and open the Capture Control 
window.

3-2-3 Exiting the Capture Application
Click the  button on the window, or select Exit from the 
File menu.

3-3 Running Capture

There are two ways to run Capture.
• Specify a range and perform batch capture (batch process).

Specify capture’s start point and end point, then perform 
capture. You can perform multiple captures in a batch 
process.

• Capture while replaying VTR (real time process).
While replaying VTR, perform capture.

You can also perform the capture and encode processes 
consecutively (Easy Encode).

3-3-1 Performing Capture in a Batch 
Process

1 On the Capture Control window, select Batch in the 
Mode block.

2 Specify capture’s start timecode and end timecode, as 
well as a file as the output destination, then click the 
[Add] button.

You cannot specify the beginning of a tape as the start 
timecode. A preroll interval is necessary.
The capture settings are added to the Project List.

3 If there are multiple scenes to capture, repeat step 2.

4 Click the [Start] button.

The capture process starts.

Notes

• When a Handycam is connected, rewind the tape 

manually. As there may be discrepancies in the start 

timecode for capture, be sure to factor in a margin of 

about 1 second.

• The capture source must be a continuous recording.

3-3-2 Performing Real Time Capture

1 Select Now in the Mode block of the Capture Control 
window.

2 Use the VTR Control block to operate the VTR and 
jump to the scene to start capture.

3 Enter a file name to output capture result.
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4 Click the [Start] button and replay the VTR.

The capture process starts.

5 When the last scene to capture appears, click the [Stop] 
button.

z Hint

You can specify the start timecode, and replay the 
VTR automatically.

3-3-3 Performing Capture and Encode 
Consecutively (Easy Encode)

1 On the Capture Control Window, select Easy Encode in 
the Mode block.

2 Specify capture’s start timecode and end timecode, as 
well as a file as the output destination, then click the 
[Add] button.

You cannot register multiple sources for Easy Encode.
You cannot specify the beginning of the tape as the start 
timecode. A preroll interval is necessary.
When you click the [Add] button, the capture settings 
are added to the Project List.

3 Click the [Start] button.

The Project Editor window appears.

4 Set up the project using Project Editor.

For details on setting up using Project Editor, refer to 
“5-5 Setting Up a Job Project,” page 50.

5 Click the [OK] button when you finish configuration.

The Encode Parameter screen appears.

6 Configure the encoding parameters in the Encode 
Parameter screen.

For details on configuring encoding parameters, refer to 
“6-2 Checking and Setting Up Encoding Parameters,” 
page 53.

7 Click the [OK] button when you finish configuration.

The capture process starts. When capture is finished, 
encoding will start automatically.
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3-3-4 Capture Control Window

a Menu bar

b VTR Control block

You can operate the VTR connected to this system, and 
monitor the captured scene.

VTR operation buttons

Slide bar
Change the replay speed of the VTR.

 button
Eject the VTR.

STAND BY button
Switch the power of VTR to standby or ON.

 button
Jump to the timecode entered in the timecode field.

 button
Copy the current timecode to Start Time Code of the Capture 
Setting block.

 button
Copy the current timecode to End Time Code of the Capture 
Setting block.

a Menu bar

d Project List block

c Capture Setting block

e Capture Control block

b VTR Control block

Menu bar Command Description

File Load Project 
File

Load a capture project file.

Save Project 
File

Overwrite and save the capture 
project file.

Save Project 
File As

Save capture project file under a 
different name.

Save Project 
File and Exit

Save the capture project file and exit 
the Capture application.

Close Close the Capture Control window to 
return to the capture project file 
selection dialog box.

Exit Exit the Capture application.

Help Version Display the version, copyright, and 
other information about this software.

Rewind the VTR.

Step a frame of the VTR in the reverse direction.

Replay VTR. During replay, clicking pauses the operation.

Step a frame of the VTR in the normal direction.

Fast forward the VTR.

Stop the VTR.
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c Capture Setting block

Mode
Select a method to process capture.
Batch: Specify multiple capture ranges and then capture all 
of them at the same time.
Now: Capture at real time while the VTR is replaying.
Easy Encode: Perform the capture and encode processes 
consecutively.

Capture Board
Display the capture board installed on the computer.

Video Format
Display the video format of the connected VTR.

Audio Format
Display the audio format of the connected VTR.

Disk Size
Display the storage capacity of the output destination for 
capture files
The red part of the graph indicates the used capacity, and the 
green part indicates the remaining capacity.
FreeSpace displays the “remaining capacity / total storage 
capacity.”

Capture File
Specify the name of a video file (.AVI) to create. Enter a 
pathname, or click the Browse button to select a file.

Separate Audio File
Select it if you want to output captured audio as audio only 
file. Enter a pathname, or click the Browse button to select a 
file.

Start Time Code
Specify the start point timecode of capture. Enter a timecode 
directly, or click the  button in the VTR Control 
block to copy the timecode being displayed.
If Mode is set to Now, select the check box only when 
specifying a start point timecode.

End Time Code
Specify the end point timecode of capture. Enter a timecode, 
or click the  button in the VTR Control block to copy 
the timecode being displayed.
This setting cannot be used if Mode is set to Now.

 button
Use the timecode specified by Start Time Code or End Time 
Code to jump to a scene on the VTR.

Duration
Specify the length of capture.
If Mode is set to Batch, this value changes according to the 
value of End Time Code.

Preprocess
Select it if you want to perform preprocess during capture.

Scene Change Detection
Select it if you want to perform scene change detection.

Pulldown Pattern Detection
Select it if you want to perform pulldown detection.

z Hint

If you want to raise the detection precision, run 
preprocessing in Source Manager.

Fixed Field Order
Use if you want to perform source detection using a 
specified field order.

For details on Fixed Field Order, refer to “4-4-2 Setting Up 
the Preprocess Operation (Preprocess Tab),” page 36.

d Project List block

During batch processing, a list of projects for capture 
appears. Projects for which the check box in the ID column 
is selected will be captured.

[Add] button
Add a capture project using the settings in the Capture 
Setting block.

[Update] button
From the list, update the currently selected capture projects 
with contents in the Capture Setting block.

[Delete] button
From the list, delete the currently selected capture projects.

vV button
Move up or down the list.
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e Capture Control block

Stop at Drop Frame
Stop capture when there is drop frame.

Auto Eject after Capture
Eject the VTR automatically after capture is finished during 
batch processing.

VTR Auto Play
If the VTR is stopped when the [Start] button is pressed 
during real time processing, playback on the VTR will start 
automatically.

[Start] button
Start capture.
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Chapter 4 Registering Sources

4-1 Chapter Outline

This chapter describes a series of operations, from how to 
use Launcher to start Source Manager, to how to customize 
detection result of Preprocess.

This chapter contains the following main contents.
• Starting and exiting Source Manager
• Registering source file
• Running Preprocess
• Customizing detection result of Preprocess
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4-2 Starting and Exiting Source Manager

4-2-1 Starting Source Manager
Click the Source Manager button of Launcher.
Source Manager starts.

4-2-2 Source Manager Screen

a Menu bar

a Menu bar

b Toolbar

c Source tree bar

d Review display 
area

e Source 
information 
display area

f Source file list

Menu bar Command Description

File Open Open a source list file.

Save Overwrite and save the source list file 
being edited.

Save As Save the source list file being edited 
under a different name.

Close Exit Source Manager.

Source Source List New: Create a new source list.
Delete: Delete the currently selected 
source list.
Modify: Modify the name of the 
currently selected source list.

Source File Add: Create a new source file.
Delete: Delete the currently selected 
source file.

Control Play/Pause Replay the currently selected source file 
or pause the operation.

Fast 
Forward

Fast forward the currently selected 
source file.

Rewind Rewind the currently selected source 
file.

Step 
Forward

Step a frame of the currently selected 
source file in the normal direction.

Step 
Backward

Step a frame of the currently selected 
source file in the reverse direction.

Jump to 
Start

Jump to the start point of the currently 
selected source file.

Jump to End Jump to the end of the currently selected 
source file.

Renderer Output review pictures to the monitor 
connected to the video output board of 
the control PC.

Menu bar Command Description
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b Toolbar

Display the source list display screen.

Display the Preprocess screen.

c Source tree view

Display the source list and source file registered in the 
system, in a tree format.

d Review display area

Perform review display of the selected source file.

Source information display
Display the source file information. If you have clicked the 
[Update] button and completed registration of a source file, 
contents set in Source Information appear. During the 
temporary registration, information obtained from the 
source file appears.

1 Video format
2 Frame rate
3 Timecode format (DF, NDF)
4 Current frame/total frame
5 Remaining time
6 Current timecode
7 Start point timecode
8 End point timecode

Review control
Operate the source file during review display.

Track bar
Move timecode to the clicked position. Rotating the mouse 
wheel step the frames.

e Source information display area

Display the source file information selected in the source 
tree view.

For details, refer to “4-3-2 Setting Up Source File 
Information (Source Information Block),” page 32.

f Source file list

In source tree view, display all source files in the currently 
selected source list.
Clicking  on the toolbar displays the 
Preprocess screen.

4-2-3 Exiting Source Manager
Click the  button on the window, or select Close from the 
File menu.

Data Scene 
Change

Import: Import scene change’s 
detection result file.
Export: Export scene change’s 
detection result to a file.

Inverse 2-3 
Pulldown

Import: Import pulldown pattern’s 
detection result from a file.
Export: Export pulldown pattern’s 
detection result to a file.

Preprocess Entry Register a project to preprocess.

Help Version Display the version, copyright, and other 
information about this software.

Menu bar Command Description

1 2 3

4 5

6

7 8

Jump to the start point of the source file.

Step a frame in the reverse direction.

Rewind the source file.

Replay or stop.

Fast forward the source file.

Step a frame in the normal direction.

Jump to the end of the source file.
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4-3 Registering Source File

4-3-1 Registering a New Source File

1 Use Explorer or a similar tool to select a source file you 
want to register, then drag and drop it to the desired 
source list in tree view.

Or, right click the source list and select Add Source 
File.
The icon of the source file is added to the bottom of the 
source list.

z Hint
To register multiple source files or source lists
When you drag and drop a folder containing source files, 
all sources files in the folder as well as any lower folders 
are registered.

2 In the Source Information block, set up the source file 
information.

In the Source Information block, information loaded 
from the dragged and dropped source file appears 
automatically. Check the displayed content and make 
changes if necessary.

For details on the Source Information block, refer to 
“4-3-2 Setting Up Source File Information (Source 
Information Block),” page 32.

3 Click the [Update] button.

Source file information is registered in the source list

Note

Until you click the [Update] button, source file 
registration is not completed. Even when you are not 
editing the source file information, always be sure to 
click the [Update] button.

4-3-2 Setting Up Source File 
Information (Source Information 
Block)

When you drag and drag a source file, information obtained 
from the source file appears automatically. If the content has 
been edited, click the [Update] button.

[Update] button
Use content specified by the Source Information block to 
update the source list.

Source ID
Enter an ID number to identify the source file.

Content Name
Enter the content name of the source file.

Source information display
Display information obtained from the source file (video 
format, frame rate, length, frame number).

Source File Name
Enter the file name of the source file.

Video Format
Specify the resolution of the video.

Frame Rate
Specify the frame rate.

Cropping Lines
If the video format is 720 × 486, specify the number of lines 
to crop.

Time Code Format
Specify the timecode format.

Note

Drop Frame can be set only when frame rate is 59.94i or 
59.94p.

Field Order
To set up Interlace, follow the specified AVI file and select 
Top Field First or Bottom Field First.
To set up Progressive, select Progressive.

Aspect Ratio
Specify the aspect ratio.
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Start Time Code
Enter the start point timecode of the source file.

End Time Code
Enter the end point timecode of the source file.

Note

The last frame of the video to be encoded is the frame 
immediately previous the frame specified by the End Time 
Code setting.

[Set] button
After entering Start Time Code, set the final timecode 
calculated from the length of the source file, in End Time 
Code.

Duration
Display the length of the source file.

Start Frame Number
To encode from the start point of an AVI file, enter 0 (see 
example 1).
If the start point of an AVI file contains unwanted video, 
enter the frame number of the unwanted portion (from start 
point to Start Time Code). By doing so, you can skip the 
unwanted portion when encoding the file (see example 2).

Example 1)
The AVI stream contains only main title and you want to 
encode from the start to the end.

Main title is 1:00:00:00 to 1:48:33:23
Frame rate is 24p

Setting value

Example 2)
The AVI stream contains main title as well as other items, 
but you want to encode only the main title.

Main title is 1:00:00:00 to 1:48:33:23
Frame rate is 24p

Setting value

Start Frame Number = 1440 = (24-60) 

[Access Point] button
Display the Input Access Point window.

Genre
Specify the genre of the source. The setting specified here is 
also applied to the Recommended Parameter tab of the 
encoding parameters.
• Film: Film sources
• CG Anime: CG animation sources
• Sports: Sports sources
• MusicLive: Live music sources
• Landscape (River, Waterfall): Landscape sources
• Static Picture: Still pictures or sources with minimal 

movement
• Not Special: Miscellaneous sources

[Jump] button
Enter a timecode in the timecode editing area, and click the 
[Jump] button to jump to that point.

Texture
Specify the picture quality of the source. The setting 
specified here is also applied to the Recommended 
Parameter tab of the encoding parameters.
• Film Grain / Camera Noise non-exist: Source with no film 

grain or camera noise
• Film Grain / Camera Noise exist: Source with film grain 

or camera noise

Parameter Value

Start Time Code 1:00:00:00

End Time Code 1:48:34:00

Start Frame Number 0

1:0:00:00

1:0:00:00 1:48:33:23

1:48:33:23

Main titleAVI file

Encode

Start Time Code End Time Code

Parameter Value

Start Time Code 1:00:00:00

End Time Code 1:48:34:00

Start Frame Number 1,440

00:59:00:00

1:0:00:00 1:48:33:23

1:50:00:00

Main titleAVI file

Encode

Start Time Code End Time Code

Unwanted portion Unwanted portion
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Input Access Point window

Number of Access Points
Display the total number of access points.

Time Code
Enter the timecode of the access point to add.
Enter the actual timecode if Actual is selected, or the 
timecode offset if Actual is not selected.

Actual
Specify whether to enter the timecode of the access point to 
add as actual timecode or timecode offset.
To enter actual timecode, select the check box. To enter 
timecode offset, clear the check box.

[Add] button
Add an access point.

[Update] button
Update access point information after information of an 
existing access point is edited.

[Delete] button
From the Access Point Information list, delete the selected 
access point.

Access Point Information list
Display access point information on the list.

4-3-3 Deleting a Source File
In source tree view, right-click the source file you want to 
delete, then select Delete.
Even when a source file is removed from Source Manager, 
the actual file is not deleted from the computer.

Menu bar Command Description

Data Import Time Code: Import the timecode in 
plain text format.
Frame: Import the frame number in 
plain text format.
XML: Import the access point in XML 
format.

Export Time Code: Export the timecode in 
plain text format.
Frame: Export the frame number in 
plain text format.
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4-4 Running Preprocess

4-4-1 Performing the Preprocess 
Operation

1 After registering a source file, click  
on the toolbar.

The source list display screen switches to the 
Preprocess screen.

2 On the Preprocess tab, select a process to run, then click 
the [Start] button.

The preprocess operation starts.

For details on the Preprocess tab, refer to “4-4-2 
Setting Up the Preprocess Operation (Preprocess 
Tab),” page 36.
When the operation is finished, the Customize tab 
appears.

3 On the Customize tab, edit the detection results of 
pulldown pattern and scene change, then click the 
[Update] button.

For details on the Customize tab, refer to “4-4-3 
Customizing the Detection Result (Customize Tab),” 
page 37.

z Hint

You can also batch process a preprocess operation. 
To do this, select Entry from the PreProcess menu, 
and register the project as a batch process.
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4-4-2 Setting Up the Preprocess Operation (Preprocess Tab)

a Status block

Scene Change Detection
Display the execution status of scene change detection.
Non-Detection : Not detected
Detected : Detected
In Progress : In progress

Pulldown Pattern Detection
Display the execution status of pulldown pattern detection.
Non-Detection : Not detected
Detected : Detected
In Progress : in progress
If a source file is not target of pulldown pattern detection, 
“-” appears.

b Scene Change Detection block

To perform scene change detection, select the check box to 
select a detection mode.
Auto : Automatic detection
Manual : Manual detection

c Pulldown Pattern Detection block

To perform pulldown pattern detection, select the check box.

Field Order
Select the field order of the source file.

Fixed Field Order
Use it if you want to perform source detection using a 
specified field order.
In the normal mode, if a pattern different from the one 
specified by Field Order is detected during pattern detection, 
an error occurs. This is because depending on the title 
incorrect detection may occur.
In this case, when you set Fixed Field Order to ON, you can 
enforce pattern detection based on the specified field order.

Mode

Auto
Select it if you want to perform automatic detection.
Limit, Rate: Display the threshold values used during 
detection.
[Configuration] button: Display the threshold value setting 
window.

Threshold value setting window

[Hard] / [Normal] / [Weak] buttons
Select threshold values for detection.

To finely adjust the threshold value, drag the vertical line bar 
or horizontal line bar of the graph to a value you want to use.

z About the detection threshold value

Adjust the detection precision of the repeat field.
Rate: When this value is increased, the number of 

repeat field detected increases.
Limit: When this value is increased, the number of 

repeat field detected decreases.

For a title with a lot of noise, when the values of both 
parameters are decreased, very few repeat fields are 
detected. On the contrary, for a title with not much noise, 

a Status block

b Scene Change 
Detection block

c Pulldown Pattern 
Detection block

Threshold Limit Rate

Hard 25 0.025

Normal 100 0.040

Weak 200 0.075
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when the values of both parameters are increased, a lot of 
repeat fields will be detected even if they are not 
(incorrect detection).

Hard: Suitable for title with a lot of noise
Normal: Suitable for normal title
Weak: Suitable for title with not much noise

Manual
Select it if you want to use a pattern file to import detection 
pattern.

[Pattern File] button
Display a screen to select pattern file.

[Start] button
Start the preprocess operation.

4-4-3 Customizing the Detection 
Result (Customize Tab)

Use this function to customize a pulldown pattern.

Customizing a pulldown pattern

Pulldown usually repeats the AA, BB, BC, CD, and DD 
patterns.

Pulldown pattern
f1: field 1
f2: field 2
t: Repeat the field
Pulldown patterns 1 to 4 (solid line frame) indicates 24 Hz 
picture structure.
On the other hand, 30 Hz frame structure is indicated by the 
dashed line frame.

Pic_Mode block
Display each frame’s pulldown pattern.

I
A AA
B BB
C BC
C CD (dummy frame)
D DD

This system enables editing of the following six patterns.
1. (AA,BB,BC,CD,DD)
2. (BB,BC,CD,DD,AA)
3. (BC,CD,DD,AA,BB)
4. (CD,DD,AA,BB,BC)
5. (DD,AA,BB,BC,CD)
6. AA (All AA)

Pattern editing procedure

1 Specify the range for performing customization.

2 Specify one of the six patterns listed above.

3 Click the [Update] button.

The customized content is updated.

4 Check to make sure that the specified pattern is 
customized.

5 When customization of all pulldown patterns is 
finished, select Close from the File menu.

Note

If the frame specified at the access point is a BC, CD, or DD 
frame, it is indicated by a red line. In this case, change the 
pulldown pattern or the location of the access point. If the 
frame at the access point is AA or BB, it is indicated by a 
yellow line. If the operation continues using the BC, CD, or 
DD frame, the access point will become invalid.

Import and export functions of pulldown file
You can import or export the pulldown pattern information 
file of each frame.

To import
From the Data menu, select Inverse 2-3 Pulldown. Click 
Import, then specify a file to import.

To export
From the Data menu, select 2-3 Pulldown. Click Export, 
then specify a file to save the information.

f1

f2

f1

f2

f1

f2

f1

f2

f1

f2
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Editing the division candidate point

1 Double-click the division point (green, bold line) in the 
scene change display editing area.

A popup menu appears.

2 Remove the check mark from Select.

3 Double-click the new division candidate point.

A popup menu appears.

4 Add the check mark to Select.

5 Click the [Update] button.

The edited contents are updated.

6 Check to make sure the division point has been 
changed.

7 When all editing is finished, select Close from the File 
menu.

Specifying the division candidate point 
manually

1 On the Preprocess tab, select Manual for Scene Change 
Detection.

2 Click the [Start] button.

3 In Time Code of Division Point on the Customize tab, 
enter the timecode and click the [Input] button.

In the scene change display editing area, the division 
candidate point is indicated by a white line.

To specify a timecode from the scene change 
display editing area
1) In the scene change display editing area, double-

click the division candidate point.
A popup menu appears.

2) Select Set.
In the scene change display editing area, the 
division candidate point is indicated by a white line.

Note

If inverse telecine has been performed, the frames of 
the following patterns cannot be set as division 
candidate points.
• BC
• CD
• DD

4 After specifying the settings, click the [Update] button.

The division candidate point is registered.

z Hint

• After automatic detection is performed, you can add 
any point.

• If the division candidate point is set up manually, we 
recommend that you specify a scene that is not 
dependent on the previous screen such as scene 
change.

Notes

• When manual detection has been set up, if you perform 
automatic detection, the point set by manual detection 
becomes invalid.

• The division candidate point set up is not always split. 
According to the system environment (number of encoder 
PCs) and interval of the division candidate points, the most 
suitable division candidate point is calculated and 
distributed encoding is performed.

To clear the division point

1) In the information display area, double-click the division 
point indicated by a white line.
A popup menu appears.

2) Select Delete.
The division point is cleared.

Customize tab screen

During pulldown pattern editing mode:
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During scene change editing mode:

Timecode scale
Select a display unit for the graduations in the graph display 
area.

Graduation width
Adjust the display width of one graduation.
Moving it to the left reduces the width while moving it to the 
right increases the width.

Current timecode
Display the currently selected timecode.

[Undo] button/[Redo] button
Use these two buttons to cancel the previous operation, or 
cancel the previous Undo operation.
Up to 20 operations can be saved. If the 20 operations are 
exceeded, existing operations are deleted from the memory, 
starting from the oldest one.

[Clear] button
Cancel all customization changes made and return to the 
default state.

[Update] button
Confirm the customization changes made.

[TC] button/[FR] button (graduation display)
Specify whether to display using timecode or relative frame 
number.
Timecode or relative frame number is displayed in every 10 
graduations.

[Pulldown] button/[Scene Change] button
Switch between the pulldown pattern editing mode and the 
scene change editing mode.

Picture Mode
If you are in the pulldown pattern editing mode, the 
pulldown pattern type of each frame is displayed.

Detection
If you are in the scene change editing mode, information of 
the detected division candidate is displayed.

Pulldown pattern display editing area
Display and edit the detected pulldown pattern.

Scene change display editing area
Display and edit the detected scene change.

[Overview] button
Display source entire file’s pulldown pattern and scene 
change in the Source Information block.

Time Code of Division Point (during scene change 
editing mode)
For scene change editing, enter any timecode.

[Input] button
Set up timecode specified in Time Code of Division Point as 
scene change.

Current on Review
Display the timecode of the displayed review screen in Time 
Code of Division Point.

Auto Decoding
Select this check box to automatically display the image of 
the current position.
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5-1 Chapter Outline

This chapter describes a series of operations, from how to 
click the Launcher button to start Project Manager, to how to 
create a target project for encoding.

This chapter contains the following main contents.
• Starting and exiting Project Manager
• Creating project: Create a new project.

- Source project: Based on the registered title, set up 

encoding conditions and create a project.

- Job project: Decide a title to create, register source file, 

set up encoding conditions, then create a project.
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5-2 Starting and Exiting Project Manager

5-2-1 Starting Project Manager
From Launcher, click the Movie button.
Project Manager starts.

5-2-2 Project Manager Screen

a Menu bar

a Menu bar
b Toolbar

c Source tree view

d Project list

e Information display 
area

Menu bar Command Description

File Close Exit Project Manager.

Project Select Path Select a folder containing projects 
saved. All jobs stored in the 
selected folder are displayed in the 
project list.

Select File Select a job file and open it.

New Job: Create a new job. 
Source Project: Create a new 
source project.

Edit Edit a project selected from the 
project list.

Delete Delete a project selected from the 
project list.

Save Update the displayed settings and 
save the project.

View Refresh Update display of the screen to its 
latest status.

Show Project 
Monitor

Display the project monitor.

Encode Parameter File Import: Import encoding parameters 
from a file that has been exported.
Export: Export the displayed 
encoding parameters to a file.

Entry Register a project for encoding.

Finalize Entry Normal: Register a project for 
normal finalization (by set).
Roll Encode: Register a project 
for Roll Encode (by video block).
For details on Roll Encode, refer to 
“5-4-2 Setting Up Source for 
Encoding (Source Tab),” page 45.

Information Project Display the definition information 
of the currently selected project.

Encode 
Parameter

Display the encoding parameters of 
the currently selected project.

Option Edit User Define 
Scaling List

Display the User Define Scaling 
List window.

Edit User Define 
QMatrix

Display the User Define QMatrix 
window.

Export - Access 
Point Data

Export access point data to a file.

Log Encode Log Display the encoding log window.

Menu bar Command Description
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b Toolbar

Display the setting information of a project that has been set 
up. The information display area switches to the 
Configuration screen.

Edit the setting information of a source project. The 
information display area switches to the source project 
creation screen.

Open the job project setting screen.

c Tree view

Display the registered source information in a tree format.

d Project list

Load a project file and display it in a list.

[New] button
Create a new project.

[Edit] button
Edit a currently selected project.
If the project type is job, display the Project Editor window.
If the project type is source project, display the source 
project creation screen in the information display area.

[Delete] button
Delete a project.

[Cancel] button
Cancel project editing.

[Open] button
Display the Customize Review window.

e Information display area

Display the project information when an existing project is 
selected.
Display the source project creation screen when creating a 
new source project.

5-2-3 Exiting Project Manager
Click the  button on the window, or select Close from the 
File menu.
Project Manager exits and the Launcher screen returns.

5-3 Creating and Managing 
Project for Encoding

5-3-1 Creating a New Project
The following types of projects are available.
• Source project: Create a project by setting bit rate and 

other parameters based on a source file registered in 
Source Manager.

• Job project: Decide a title to create, register the source file 
that will be used, and set the bit rate and other parameters.

The following sections describe how to create a project.

Creating a source project

1 Click the [New] button in Project Manager.

Project Manager’s information display area changes to 
the source project creation screen.

2 On the source project creation screen’s Project tab, set 
up content name and other parameters, then click the 
[Update] button.

For details, refer to “5-4-1 Setting Up the Basic 
Information of a Project (Project Tab),” page 43.

3 Use the Source tab to set up the source file.

You can also use drag-and-drop to specify the source 
file.

For details, refer to “5-4-2 Setting Up Source for 
Encoding (Source Tab),” page 45.

4 Use the Configuration tab to set up video block and 
angle unit, then click the [Update] button.

For details, refer to “5-4-3 Setting Up Video Block and 
Angle Unit (Configuration Tab),” page 47.

5 Use the Size tab to set up size information, then click 
the [OK] button.

For details, refer to “5-4-4 Setting Up Size Information 
(Size Tab),” page 49.

6 When the Project Review window appears, click the 
[Save] button in the window.

Help Version Display information on the 
software such as the current 
version and copyright information.

Menu bar Command Description
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Creating a job project

1 Click the [New] button in Project Manager.

The dialog box for selecting the job type appears.

2 Select Job, and click the [OK] button.

The Project Editor window appears.

3 Configure the project settings in each of the tabs of the 
Project Editor window.

For details, refer to “5-5 Setting Up a Job Project,” 
page 50.

4 Click the [Update] button when configurations for each 
tab are finished.

5 Use the Size Information tab to set up size information, 
then click the [OK] button.

6 When the Project Review window appears, click the 
[Save] button in the window.

5-3-2 Editing an Existing Project

1 From the project list in Project Manager, select an 
existing project.

Project Manager’s information display area switches to 
the Configuration screen.

2 Use the Configuration screen to edit the basic settings 
of job.

For details, refer to “6-2 Checking and Setting Up 
Encoding Parameters,” page 53

3 To edit parameters for encoding, select the Encode 
Parameter tab and perform the settings.

4 On the Encode Parameter tab, click the [OK] button.

5 Use the Size or Size Information tab to set up size 
information, then click the [OK] button.

6 When the Project Review window appears, click the 
[Save] button in the window.

5-4 Setting Up a Source Project

To set up a source project, use Project Manager’s source 
project creation screen.

Tree view area

Contents (set, video block, angle unit) appear in the tree 
format. To edit a content, select it from the tree view area.

5-4-1 Setting Up the Basic Information 
of a Project (Project Tab)

VENC XML File Pathname

Specify the pathname of the destination for saving a project 
(VENC.XML file). Enter a pathname, or click the Browse 
button to select a destination. In the specified output 
destination folder, a folder with the content name entered in 
the Content Name text box is created automatically and the 
project (VENC.XML) file is saved in the created folder.

Tree view area
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To specify the pathname, you can also use Explorer or a 
similar tool to drag and drop a folder.

Job ID
Enter the ID of a job to create (letter or number up to 6 
characters).

Content Name
Enter the content name of a job to create (up to 255 
characters).
A folder with the entered name is automatically created at 
the location specified by VENC XML File Pathname and 
Project Data Pathname.

Note

In this software, a folder with the name specified by Content 
Name is created underneath the folder specified by VENC 
XML File Pathname. For this reason, the name cannot 
exceed 255 characters in total.

Project Data Pathname

Enter a pathname to use for saving intermediate files created 
when a project is executed. Enter a pathname, or click the 
Browse button to select a destination. Inside the folder 
specified by the pathname, a folder with the content name 
entered in Content Name is created automatically and then 
intermediate files are stored in this folder.

Video Mode
Select a video format for encoding.
BDMV: Encode using a format for BD-ROM.
DVD: Encode using a format for DVD.
By default, BDMV is used.

[Update] button
Confirm the Project tab settings.
When you click the [Update] button, the Source tab can now 
be selected.
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5-4-2 Setting Up Source for Encoding (Source Tab)

Adding source

For the source, you can use Source tab’s Source Filename to 
specify, or drag and drop a source file.
If you want to drag and drop a source file, use the source tree 
view and select a source file, then drag and drop it to the 
source project creation screen’s tree area or Source File 
Name.
According to the status when you drag and drop the source 
file, a hierarchy is automatically created.

z Hint

If you drag and drop the source file on the root (highest 
level) of the hierarchy, a new Set branch is created.
If you drag and drop the source file on a Set branch, a 
new Video Block branch is created.

Multi-source

Normally, one source is defined for one Angle Unit (single 
source). However, multiple sources for one Angle Unit are 
also possible (multi-source). In a multi-source project, use 
the Source tab to specify multiple sources.

a Source block

Set ID
Display the Set ID of the currently selected source in tree 
view.

Video Block ID
Display the Video Block ID of the currently selected source 
in tree view.

Angle Unit No.
Display the angle unit number of the currently selected 
source in tree view.

b Selected Source block

Source Filename
Use one of the following operations to specify the source 
file’s pathname.
• Enter a pathname.
• Click the Browse button to display the source selection 

window and select a file.
• Drag and drop in the source tree view.

Video Format
Display the video format.

Frame Rate
Display the frame rate.

Time Code Format
Display the timecode format.

Field Order
Display the field order (only if source is interlace).

Start Time Code
Display the start point timecode.

End Time Code
Display the end point timecode.

c Source List block

Total Duration
Display the total time.

[Add] button
Add a source file. Clicking this button displays the range 
dialog box.

a Source block

b Selected Source block

c Source List block
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In a multi-source project, click the [Add] button to add 
sources.

Range dialog box

Source Filename
Specify a source file name. Enter a file name, or click 
the Browse button to select a file.
When you enter a source file name, the source file 
information appears.
Video Format: Video format
Field Order: Field order
Duration: Length
Frame Rate: Frame rate
Time Code Format: Timecode format
Start Time Code: Start point timecode
End Time Code: End point timecode

Start Time Code
Specify the start point timecode of the scene to add to a 
project.

End Time Code
Specify the end point timecode of the scene to add to a 
project.

Duration
Display the length from the start point timecode to the 
end point timecode.

[Edit] button
Change the settings of the source file currently selected from 
the source list.

[Delete] button
Delete the currently selected source file from the source list.

Note

The first source file cannot be deleted.

Source list
Displays source files in a list format.
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5-4-3 Setting Up Video Block and Angle Unit (Configuration Tab)

Roll Encode Mode
When there are multiple video blocks in a set, the video 
blocks are combined into a single stream under normal 
finalization.
However, you can also configure and encode sources (rolls) 
block by block before combining them into a single stream.

Note

To use Roll Encode Mode, a set must contain multiple video 
blocks with each block having the same codec, format, and 
frame rate. In addition, this mode does not support multi-
angle.

Set ID
Display the Set ID of the currently selected source file.

Video Block ID
Display the Video Block ID of the currently selected source 
file.

Angle Unit No.
Display Angle Unit No. of the currently selected source file.

Video Mode
Display the video mode of the currently selected source file.

a Video Block block

Set up video block information. If there are multiple video 
blocks, set up information for each video block, and then 
click the [Update] button.

Source Video Format
Display the resolution of the source file.

Frame Rate
Display the frame rate of the source file.

Encode Video Format
Specify the resolution to use after encoding.

Content Class
Specify the genre of the video for encoding.
While it does not affect encoding, it provides a handy 
description in stream management.

Codec Class
Specify the type of encoding (H.264/AVC, MPEG-2).

Aspect Ratio
Specify the aspect ratio.

z Hint

You can select 16:9 (Pan/Scan) aspect ratio for DVD 
projects. To configure Pan/Scan settings during 
authoring, select 16:9 (Pan/Scan).

Video Type
Specify the type of ES file for encoding.
Primary: Primary video stream
Secondary: Secondary video stream

Profile level
Specify the profile’s level.

Encode Style
Specify whether to encode using 2 passes (2 Pass VBR or 
Fast 2 Pass VBR) or 1 pass (1 Pass CBR or 1 Pass VBR 
(AVC encoding only)).

Encode Mode
Specify multi-angle information.

Inverse 2-3 Pulldown
If this check box is selected, pulldown pattern can be 
detected during preprocess.

For details on Inverse 2-3 Pulldown editing, refer to 
“Customizing a pulldown pattern,” page 37.

a Video Block block

b Angle Unit block
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Use Access Point
To use access point, select the check box.

[Access Point] button
Display the Input Access Point window and specify access 
point.

For details on the Input Access Point window, refer to 
“Input Access Point window,” page 34.

Stream ID Generator
If this check box is selected, the bitmap file specified in 
System Setup is inserted.

b Angle Unit block

Source Information

Time Code Format
Display the source file’s timecode format.

Field Order
Display the source file’s field order.

Start Time Code
Display source file’s start point timecode.

End Time Code
Display source file’s end point timecode.

Source Filename
Specify the source file name.

[Copy to Time Code] button
Set the source file’s Start Time Code and End Time Code to 
Start Time Code and End Time Code.

Start Time Code
Specify the start point timecode for encoding.

End Time Code
Specify the end point timecode for encoding.

Duration
Display the length of encoding.

Time Code Stamp
Enter the start point timecode to set up in bitstream.

Sequence End Code
Select it when to specify sequence encoding.

Seamless Connection
To set up seamless connection, select it.

Closed Caption
Specify whether to insert closed caption data in video 
stream.
If you do not want to insert closed caption data: Select “No 
Insert.”

If you want to insert closed caption data: Select “Insert CC 
Data from File,” then specify a *.cc file.
If you want to insert dummy data: Select “Insert Dummy CC 
Data.” Insert the dummy data in the Muxer or other 
applications used after the encoder.

Filename Prefix
Enter a name prefix to use for saving video stream files.
The prefix is automatically attached to the front of a video 
stream file name.

Destination Pathname
Specify a pathname to use for saving stream files created. 
Enter a pathname, or click the Browse button to select a 
pathname.

[Update] button
Confirm the Configuration tab’s settings.
When you click the [Update] button, the Size tab can now be 
selected.

Note

The maximum length for encodings that can be registered to 
a single angle unit is about two hours (one tape).



5-4 Setting Up a Source Project 49

C
h

ap
ter 5

5-4-4 Setting Up Size Information (Size Tab)

a Set Size block

Set ID
Display the currently selected set ID in tree view.

Target Size
Enter the target size of the currently selected set ID.

Customize Available Size
Enter the size of the data area for customization.

Set Assigned Size
Display the size assigned to the set ID.

[Update] button
Confirm the Set Size block’s settings.

Set Size list
Information related to the size of the set ID appears in a list

b Video Block Size block

Set ID
Display the currently selected set ID in tree view.

Video Block ID
Display the currently selected video block ID in tree view.

Average Bit Rate
Specify the average bit rate for video encoding. (Maximum 
value is 400 × 100 kbps.)

Note

It cannot be set in 1 pass CBR. Specify only Maximum Bit 
Rate.

Maximum Bit Rate
Specify the maximum bit rate for video encoding. 
(Maximum value is 400 × 100 kbps.)

Set All Video Block
Select this to configure the same bit rate for all video blocks.

[Update] button
Confirm the Video Block Size block’s settings.

Video Block Size list
Information related to the sizes of the video blocks appears 
in the list.

Update status display
Displays whether the video block information has been 
updated.
If the information has not been updated, return to the 
Configuration tab and click the [Update] button.

[OK] button
Confirm the project settings.
The Project Review window appears when you click the 
[OK] button.

5-4-5 Project Review Window

[Print Preview] button
Preview the displayed settings.

a Set Size block

b Video Block Size block
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[Print] button
Print out the displayed settings.

[Save] button
Click the [Save] button if the displayed settings are correct.
The project is saved and the content name is registered.

[Cancel] button
Click the [Cancel] button to return to the Size tab and edit the 
project settings.

5-5 Setting Up a Job Project

Use Project Editor to set up a job project.

Menu bar

5-5-1 Setting Up the Basic Information 
of a Project (Index Tab)

VENC XML File Pathname
Specify the pathname of the destination for saving a project 
(VENC.XML file).

Job ID
Enter the ID of a job to create.

Content Name
Enter the content name of a job to create.

Project Data Pathname
Enter a pathname to use for saving intermediate files created 
when a project is executed.

Menu bar Command Description

File Save Save the settings.

Save and Close Save the settings and close the 
Project Editor window.

Import Import project information created 
with BAE-VA700.

Close Close the Project Editor window.

Option Roll Encode 
Mode

Check the set ID for which to 
execute Roll Encode.
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For details, refer to “5-4-1 Setting Up the Basic Information 
of a Project (Project Tab),” page 43.

Number of Sets
Specify the number of sets to determine the target size for the 
completed project.

[Update] button
Confirm the Index tab settings.
When you click the [Update] button, the display switches to 
the Video Block tab.

5-5-2 Video Block tab

The settings in this tab are the same as those found under the 
Video Block block in the Configuration tab of Project 
Manager.

For details, refer to “5-4-3 Setting Up Video Block and 
Angle Unit (Configuration Tab),” page 47.

[Update] button
Confirm the Video Block tab settings.
When you click the [Update] button, the display switches to 
the Video Block1 tab.

5-5-3 Video Block1 tab

Video Block Information block

Video Block ID
Display the Video Block ID selected in the tree view.

Codec Class
Display the type of encoding.

Video Format
Specify the video format of the sources.

Frame Rate
Specify the frame rate of the sources.

Encode Style
Select whether to use two-pass (2 Pass VBR or Fast 2 Pass 
VBR) or one-pass (1 Pass CBR or 1 Pass VBR (AVC only)) 
encoding.

Encode Mode
Specify multi-angle information.

Inverse 2-3 Pulldown
Select this check box to encode using the pulldown pattern 
detected during preprocessing.

For details on Inverse 2-3 Pulldown editing, refer to 
“Customizing a pulldown pattern,” page 37.

Use Access Point
Select this check box to use access points.

[Access Point] button
Display the Input Access Point window, and configure 
access points.

For details on the Input Access Point window, refer to 
“Input Access Point window,” page 34.

Stream ID Generator
If this check box is selected, the bitmap file specified in 
System Setup is inserted.

Angle Unit block

The settings in this tab are the same as those found under the 
Angle Unit block in the Configuration tab of Project 
Manager.

For details, refer to “5-4-3 Setting Up Video Block and 
Angle Unit (Configuration Tab),” page 47.

[Update] button
Confirm the Video Block1 tab settings.
When you click the [Update] button, the Size Information tab 
becomes selectable.
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5-5-4 Size Information tab

The settings in this tab are the same as those found in the 
Size tab of Project Manager.

For details, refer to “5-4-4 Setting Up Size Information (Size 
Tab),” page 49.

[OK] button
Confirm the Project Editor settings.
The Project Review window appears when you click the 
[OK] button.

For details on its contents, refer to “5-4-5 Project Review 
Window,” page 49.
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Chapter 6 Encoding

6-1 Chapter Outline

This chapter describes a series of operations, from how to 
perform the encoding process, to how to customize after 
encoding.

This chapter contains the following main contents.
• Checking and setting up encoding parameters
• Selecting and running job for encoding
• Checking encoding result
• Performing customization after encoding

6-2 Checking and Setting Up 
Encoding Parameters

1 On Project Manager’s toolbar, click  
and display the Configuration screen.

2 From the Project list, select a project for setting up 
parameters.

3 Selected the Recommended Parameter tab and set up 
the characteristics of the source file.

According to the characteristics of the source file, the 
recommended parameters are automatically set up.

For details, refer to “6-2-2 Setting Up Recommended 
Parameters (Recommended Parameter Tab),” page 55.

4 Use the Encode Parameter tab to check and set up 
detailed parameters.

For details, refer to “6-2-3 Performing Detailed 
Settings of Encoding (Encode Parameter Tab in the 
Case of H.264/AVC),” page 56 or “6-2-4 Performing 
Detailed Settings of Encoding (Encode Parameter Tab 
in the Case of MPEG-2),” page 60.
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6-2-1 Displaying the Basic Conditions of Encoding (Configuration Tab)

The Configuration tab displays information on the currently 
selected project.

a Tree display area

Display information on the currently selected project in the 
tree format.

b Detailed information area

Display detailed information on the currently selected 
parameter in the tree view.

a Tree display area b Detailed information area
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6-2-2 Setting Up Recommended Parameters (Recommended Parameter Tab)
Use Characteristic of source file on the Recommended Parameter tab to specify the source file’s properties (genre, picture 
quality).
When you click the [Set] button, parameters most suitable for the source file’s properties appear.
If there are multiple video blocks, specify parameters for each video block.
When settings of all video blocks are completed, click the [Update] button.
Parameters displayed in the parameter list are saved, and the Encode Parameter tab appears.

Video Block ID
Select a video block ID for setting up the parameters.

Codec Class
Display the type of encoding.

Profile Level
Display the profile’s level.

Encode Style
Display the encoding style.

Configuration block

Video Format
Display the video’s resolution.

Frame Rate
Display the frame rate.

Average Bit Rate
Display the average bit rate of encoding.

Genre
Specify the genre of the source.
• Film: Film sources
• CG Anime: CG animation sources
• Sports: Sports sources
• MusicLive: Live music sources
• Landscape (River, Waterfall): Landscape sources
• Static Picture: Still pictures or sources with minimal 

movement
• Not Special: Miscellaneous sources
• Black Belt: Sources with black bars at the top and bottom 

(letterboxing)

z Hint

The options that are available vary depending on the 
video format and rate settings.
For example, Black Belt does not appear when MPEG2 
is selected.

Texture
Specify the picture quality of the title.
• Grain non-exist:

Source with no film grain or camera noise
(Quality/Speed are reflected in the Encode Quality setting)

• Grain exist:
Source with film grain or camera noise
(Quality/Speed are reflected in the Encode Quality setting)

Set All Video Block
Apply parameters to all rolls.

[Reset] button
Return the settings to their defaults.

[Set] button
Set up the parameters using the specified contents.
Recommended parameters appear in the parameter list.

Parameter list
Display parameters set up in each video block in a list 
format.

[Parameter List] button
Display the parameter list window.

[Update] button
Update the parameter setting file after all settings of the 
video block are performed.
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6-2-3 Performing Detailed Settings of Encoding (Encode Parameter Tab in the 
Case of H.264/AVC)

Check and set up parameters for encoding in H.264/AVC.
Set up parameters for each video block, then click the [Update] button.
After settings of all video blocks are completed, click the [OK] button.

a Setting Encode Parameters block

Video Block ID
Select a video block ID for setting up parameters.

Codec Class
Display the type of encoding.

Profile Level
Display the profile’s level.

Encode Style
Display the encoding style.

b Video Block block

Encode Quality
Perform settings related to the encoding quality.
Quality: The best picture quality can be obtained but 
encoding takes time.
Speed: The picture quality and encoding time both fall 
between Quality and Express.
Express: The picture quality is not as good as the other two 
modes, but we recommend this mode when prioritizing 
speed.
The default mode is Quality.

z Hint

If your focus is image quality, we recommend that you 
use the Quality mode to perform encoding.

[Auto Customize] button
Open the automatic customization setting window.

Note

The Auto Customize function can be used only for 2 pass 
VBR.

Low Pass Filter
Configure the low pass filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

De-Noise Filter
Configure the de-noise filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

z Hint

The CG Mode filter is effective for CG animation 
sources.

a Setting Encode 
Parameters block

b Video Block block

c High Profile block

d Custom Setting block

e Video Signal Type 
Present block

f GOP Setting block
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Automatic customization setting window

Num of Candidate
Specify the number of candidates for automatic 
customization (2 to 5). The default is 5.

Weight Interval
Specify the width of weight (1 to 10). The default is 1 
(1=10%, 10=100%).
(Example)
If the number of candidates is set to 5 and the width of 
weight to 2(=20%), using 100 as the base, five 
candidates (120, 140, 160, 180, 200) are encoded at 
20% interval.

Threshold
Specify the degree of detection.

Weak: Detection cannot be made.

Hard: Detection range is widened.

The default is Normal.

c High Profile block

Perform detailed settings if encoding is done using High 
Profile.

Scaling List
Set up Scaling List.
When High Profile is selected, the method to perform 
encoding by adding weight to each frequency component 
contained in the image can be used.

z Hint

• Scaling list refers to “weight of each frequency 
component.”
In this software, you can select from the preset scaling 
list.

• For general movie titles, if you want to improve the 
reproducibility of grain (particle shape) noise, we 
recommend that you use the following options 
according to the format of the title.
Grain Preserved (Progressive)
Grain Preserved (Interlace)
For other titles, we recommend that you use Default.

• When titles such as CG are encoded, in rare cases 
unnatural noise of grid shape may occur. In this case, 
we recommend that you use Dither Noise Reduction.

• If you set the average bit rate to 8 Mbps or below when 
encoding HD sources that include high-range 
components such as noise, the picture quality may 

deteriorate. In this case, we recommend that you use 
Low Rate.

• To improve reproduction when encoding animated 
sources (Progressive) at an average bit rate of 30 Mbps 
with grain noise present, we recommend that you use 
Grain Anime.

• When encoding sources that include camera noise, 
noise reproducibility may decrease. In this case, we 
recommend that you use High Feq. Preserved 
(Interlace).

• When encoding sources that include grain noise that is 
similar to white noise, GOP unit flicker may become 
noticeable. In this case, we recommend that you use 
Heavy Noise.

For details, refer to “To change the scaling list (Scaling 
List),” page 72.

DCT Size
Specify the DCT size selection method.

User Define
Select a user-defined scaling list.

User Define ID
Select a User Define ID. It is valid only when User Define is 
selected from Scaling List and then Others is selected from 
User Define.
To define a user-defined scaling list, select Edit User Define 
Scaling List from the Option menu to display the User 
Define Scaling List window.

User Define Scaling List window

a Menu bar

b [Reset] button

c [Default] button
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a Menu bar

ID
Select a Scaling List ID.

Remark
Enter remarks.

b [Reset] button

Return to the values before the change (when the window 
starts).

c [Default] button

Return to the default value (16).

Scaling List Copy window

4 × 4
Copy scaling list parameters selected in 4 × 4 Copy origin to 
the macro block selected in 4 × 4 Copy destination.

8 × 8
Select to copy the 8 × 8 Intra MB Y parameters to 8 × 8 Inter 
MB Y, or copy the 8 × 8 Inter MB Y parameters to 8 × 8 Intra 
MB Y.

d Custom Setting block

Detect Scene Change
Specify a scene change detection mode.

Weight Prediction
This is a technique to efficiently encode fade-in or fade-out.
The default is ON.

QP Weighting
Specify the bit rate assignment for each picture type.
• 0:0:2 Qp Balance: Increase the assignment of B Picture 

only.
• 0:2:4 Qp Balance: Increase the assignment of P, B 

Picture. (B Picture focused)
• 0:2:2 Qp Balance: Increase the assignment of P, B 

Picture. (P, B Picture same)
• Dynamic auto: Evaluate the title automatically and 

change the assignment appropriately.

z Hint

For titles with film grain feel or normal titles with 
motion, we recommend that you specify 0:2:2 Qp 
Balance.
For still images or titles with almost no motion, we 
recommend that you specify Dynamic auto.

Trailing Suppress
Specify to whether use an algorithm which reduces the 
Trailing phenomenon.
(Trailing phenomenon: This is a phenomenon that occurs 
during low bit rate encoding for screen containing scenes 
with little change. When the edge (border) moves 
horizontally, it becomes an unnatural image that looks like it 
has been dragged.)
• Animation: This algorithm is suitable for animation and 

CG titles.
• Normal: This algorithm is suitable for normal titles.

z Hint

Limit it to scene where the Trailing phenomenon occurs. 
In other cases, we recommend that you set it to OFF.

Gradation Improvement
Specify whether to use the algorithm which improves the 
picture quality of flat areas such as gradation.

z Hint

We recommend disabling this function for sources with 
sharp changes in brightness.

Refresh Suppress
Specify whether to use the algorithm which reduces the 
Refreshing phenomenon.

Menu bar Command Description

Edit Reset All Return to the values before the 
change (when the window starts).

Default All Return to the default value (16).

Scaling List 
Copy

Open the Scaling List Copy 
window.

Data Import Load the Scaling List file.

Export Save the Scaling List file using a 
file name specified by the user.
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(Refreshing phenomenon: This is a phenomenon in scenes 
with little motion where images appear to be moving 
between the I and IDR interval.)

z Hint

If sufficient amount cannot be assigned to title (when bit 
rate is low), to reduce the Refresh phenomenon, we 
recommend that you set it to ON. In other cases, set it to 
OFF.

M Pattern
Specify an M pattern.

Maximum Slice Number
Specify the number of slices (4 or 1)*.
* If AVC’s LEVEL is set to 4.1, the number of slices is fixed 

at 4. If AVC’s LEVEL is not set to 4.1, the number of 

slices can be set to 4 or 1. (The default is 4.)

z Hint

Set the AVC LEVEL in the Configuration tab of Project 
Manager.

Deblocking Filter
Select it if you want to enable the deblocking filter.

User Setting
Select it if you want to directly specify the values of the 
deblocking filter coefficients α and ß.

Auto Setting
Select it if you want to automatically adjust the values of the 
deblocking filter coefficients α and ß according to the degree 
of occurrence of block noise.

Deblocking Alpha / Deblocking Beta
Specify the offset values of coefficients α and ß when User 
Setting is selected.

z Hint

When the deblocking filter is enabled, while block noise 
is reduced, the opposite is that comparing with the 
original title the feel of quality may be damaged.

e Video Signal Type Present block

Color Description
Specify whether to include color information in stream.

Not Present: Include in the stream.

Present: Include VUI information below Color 
Primaries in the stream.

Video Format
Specify the video format.

f GOP Setting block

Perform settings related to GOP.

Default Interval
Specify the default I picture interval (unit: frame).

Max Interval
Specify the maximum I picture interval (unit: frame).

IDR Interval Factor
IDR (Instantaneous Decoder Refresh: Instantaneous refresh 
of decoder recovery operation) Specify the picture interval.

GOP Structure Map
Specify the ON/OFF of GOP Structure Map as well as the 
standard interval.
Specify whether to insert APP in a fraction of the default I 
picture interval.
This setting is available when the GOP Structure Map check 
box is selected.

Set All Video Block
If the check box is selected, you can update all video blocks 
with the encoding parameter settings.

[Reset] button
Return to the default settings.

[Update] button
Update video blocks with the encoding parameter settings.

[Parameter List] button
Display the parameter list window. You can check the 
parameters set up for each video block ID.

[OK] button
Confirm all settings.
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6-2-4 Performing Detailed Settings of Encoding (Encode Parameter Tab in the 
Case of MPEG-2)

Check and set up parameters for MPEG-2 encoding.
Set up parameters for each video block, then click the [Update] button.
After settings of all video blocks are completed, click the [OK] button.

a Setting Encode Parameters block

Video Block ID
Select a video block ID for setting up parameters.

Codec Class
Display the type of encoding.

Profile Level
Display the profile’s level.

Encode Style
Display the encoding style.

b Video Block block

Encode Quality
Perform settings related to the encoding quality.
Quality: The best picture quality can be obtained but 
encoding takes time.
Speed: The picture quality is lower than Quality, but shorter 
time is required to complete encoding.
The default mode is Quality.

Note

Depending on your operating environment, the difference in 
processing speed between Quality and Speed encoding may 
be less noticeable.

z Hint

If your focus is image quality, we recommend that you 
use the Quality mode to perform encoding.

[Auto Customize] button
Open the automatic customization setting window.

Note

The Auto Customize function can be used only for 2 pass 
VBR.

Low Pass Filter
Configure the low pass filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

De-Noise Filter
Configure the de-noise filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

z Hint

The CG Mode filter is effective for CG animation 
sources.

a Setting Encode 
Parameters block

b Video Block block

c GOP Setting block d Custom Setting block
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Automatic customization setting window

Num of Candidate
Specify the number of candidates for automatic 
customization (2 to 5). The default is 5.

Weight Interval
Specify the width of weight (1 to 10). The default is 1 
(1=10%, 10=100%).
(Example)
If the number of candidates is set to 5 and the width of 
weight to 2 (=20%), using 100 as the base, five candidates 
(120, 140, 160, 180, 200) are encoded at 20% interval.

Threshold
Specify the degree of detection.

Weak: Detection cannot be made.

Hard: Detection range is widened.
The default is Normal.

c GOP Setting block

GOP Type
Specify Closed GOP or Open GOP.

M Pattern
Specify M pattern.

Max Interval Sec
Specify the maximum I picture interval (unit: frame).

Base N
Specify the I picture interval (unit: frame) to be used as the 
standard.

d Custom Setting block

Detect Scene Change
Specify a scene change detection mode.

MQW
Select ON/OFF of MQW.

Slice Num
Specify the number of slices (1 to 16).

QMatrix
Set up QMatrix.

User Define
Select a user-defined QMatrix.

User Define ID
Select a User Define ID. It is valid only when User Define is 
selected from QMatrix and then Others is selected from User 
Define.

To define a user-defined scaling list, select Edit User Define 
QMatrix from the Option menu to display the User Define 
QMatrix window.

User Define QMatrix window

ID
Select a QMatrix ID.

Remark
Enter remarks.

[Reset] button
Return to the values before the change (when the window 
starts).

[Default] button
Return to the default value (16).

Set All Video Block
If the check box is selected, you can update all video blocks 
with the encoding parameter settings.

[Reset] button
Return to the default settings.

[Update] button
Update video blocks with the encoding parameter settings.

Encoding parameter list
You can check the parameter list set up for each video block 
ID.

[Parameter List] button
Display the parameter list window. You can check all the 
parameters set up.

[OK] button
Confirm all settings.
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6-2-5 Registering and Performing the 
Encoding Operation

1 From the Project Manager, select a project from the list 
for encoding.

2 Select Entry from the Encode menu.

The Project Monitor screen appears.

3 Click the [Start] button.

The Project Monitor screen displays the encoding 
progress status.

6-2-6 Monitoring Encoding (Project Monitor Screen)
The Project Monitor screen appears when you select Entry from the Encode menu, or when you click the Project Monitor button 
in the Tool block of the Launcher screen.
The encoding progress status appears on the Project Monitor screen.

a Menu bar

b Toolbar

Display the encoding window.

a Menu bar

b Toolbar

c Project list

e Information display 
area

d Log display area

Menu bar Command Description

File Close Exit Project Monitor.

Option Auto start Select whether to start encoding 
automatically when a project is 
registered.

View Toolbar Select to display or hide the toolbar.

Statusbar Select to display or hide the status 
bar.

Window Cascade Cascade windows for display.

Tile Vertical Tile windows vertically for display.

Tile Horizontal Tile windows horizontally for 
display.

Help Version Display the version, copyright, and 
other information about this 
software.

Menu bar Command Description
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Display the Finalize window.

Display the Preprocess window.

c Project list

Registered projects appear in the list.
The project status is indicated by the following icons.

: Target of execution

: Not target of execution

: Execution in progress

: Normal termination

: Abnormal termination or cancellation

Selected Data / All Data
Select whether to start processing the selected project only, 
or all projects.

[Delete] button
Delete the selected project.

[Disable] / [Enable] button
Disable or enable the selected project as target for execution.

[Reset] button
Reset the status of a project and specify it as target of 
execution.

v / V button
Move the project up or down.

[Start] button
Start the process.

Project list
Display registered projects in a list.
Contents Name: Content name
Order: Registered content of process
Status: Project status
Registration: Registration date and time
Start: Process start date and time
End: Process end date and time
Processing: Time elapsed in process
Remain: Estimated remaining time of process
Description: Details of process content

d Log display area

Display the execution log of process.

e Information display area

Display information on the selected project.

6-3 Customization Review

You can decode video that has been encoded before, and 
review it.
Also, you can use the customization function to improve the 
picture quality of the necessary segments. Then, you can 
reencode a minimum interval containing the segments 
specified for customization.

1 From the Project list of Project Manager, select a 
project you want to review, then click the [Open] 
button.

The Customize Review window appears.

2 Use the control buttons in the review display area to 
replay the encoded project.

For details, refer to “6-3-2 Reviewing a Project,” page 
65.

3 To perform customization, operate the customization 
area.

For details, refer to “6-3-3 Customization Function,” 
page 66.

When you select a set in the project information display area 
for projects that are encoded in Roll Encode Mode, you can 
review a stream file that combines all the video blocks 
within the set into one block.
In this case, only the review function is enabled during 
review, and you cannot display or configure customization 
information. Select any item other than a set, to return to 
normal mode.
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6-3-1 Customize Review Window

a Menu bar

b Project information 
display area

c Review display area

d Jump list

e Customization area

a Menu Bar

Menu bar Command Description

File Close Close the Customize Review window.

Customize 
Data

Latest File Replace with the latest customization 
information file.

Original 
File

Replace with the default customization 
information file.

Import File Import a customization information file 
that has been exported.

Export File Export the current customization 
information to a file.

Encode Entry Register reencoding for the currently 
opened project.

Encode Retake 
Setting

After encoding, replace a section of the 
source in the project currently opened 
and reencode.
For details, refer to “6-3-7 
Reencoding,” page 83.

Review Force SDI 
Field Mode

Specify the Force SDI Field Mode.SD 
source is output with the top field first, 
and HD source is output with the 
bottom field first.

Force 
Secondary 
Video Mode

Secondary video of SD 720 × 480 is 
forced to output at 29.97P.

Renderer Output review pictures to the monitor 
connected to the video output board of 
the control PC. 
Setting: Specify the Renderer 
combination. 
Reset: Reset the setting.

Information Auto 
Customize

Open the Auto Customize window.

Check Point Open the Check Point window.

Option Jump List 
Setting

Display the Jump List Setting screen 
and specify parameters for display in 
Jump List.

Auto Range 
Adjust

If the specified customization range is 
larger than the display range, the 
display range is changed automatically.

Move to 
Current 
Time Line

During review, the time line of the 
customization area is moved 
automatically according to the display.

Log Encode Log Display the encoding results.

Menu bar Command Description
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 button
Maximize the Customize Review window.
To undo, press the Alt + F4 keys or Alt + Esc keys.

 button
Display the Result View window.

b Project information display area

Display project information.

c Review display area

Decode project, then display the review picture.

For details, refer to “6-3-2 Reviewing a Project,” page 65.

d Jump list

Display Jump List of the project.
Select a jump destination from the list. When you double-
click it, it moves to the selected timecode.

For details, refer to “6-3-7 Reencoding,” page 83.

e Customization area

Perform customization of the project.

For details, refer to “6-3-4 Customization Screen,” page 68.

6-3-2 Reviewing a Project

Review display area

a Review area

Display the decoded image.

Notes

• The picture quality of the decoded image displayed on the 
PC depends on the graphics board.

• When displaying SD data, one extra frame may be 
displayed.

b Review information display area

Track bar
Indicate the position displayed on the current screen.
When you rotate the mouse wheel on the track bar, you can 
step a frame forward or backward.

Selecting file type
Select file type for review display. You can display encoded 
bitstream file or source file.

Note

When using a Blackmagic Design Intensity card, the source 
file may not display depending on the format.

Operation buttons

Speed adjustment slide bar
Adjust the playback speed (0.1× speed to same speed). 
Sliding the switch down decreases the playback speed. 

[FW] / [BW] button
Switch the playback direction. The playback direction 
appears on the button.
FW: Replay in the normal direction.
BW: Replay in the reverse direction.

[Field View] button
Switch the field display mode. 

Help Version Display the version, copyright, and 
other information about this software.

Menu bar Command Description

b Review information display area

c

a Review area

Move to the beginning of the source.

Rewind at 2× speed.

Step a frame at the reverse direction.

Replay or pause.

Step a frame in the normal direction.

Fast forward at 2× speed.

Move to the end of the source.

[Prev] Move to the previous access point.

[Next] Move to the next access point.
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The field display mode is a mode that enables you to replay 
frame in units of field during frame playback or pause of 
interlace source. 
If normal playback is performed, the field display mode 
becomes OFF (frame display).
FRM: Frame display (field display mode OFF)
TOP: Top field first
BTM: Bottom field first

[Interpolation] button
Enable or disable interpolation. Interpolation is valid only 
when converting from 1440 × 1080 to 1920 × 1080.

[Mark] button
Register the currently displayed timecode to the jump list.

c Bit occurrence rate display area

Display the bit rate and bit occurrence rate.

Note

Frame data rates in bit/s are displayed for the bit rate.

6-3-3 Customization Function

Common functions

Specifying picture type (Picture Type)
You can specify I picture and IDR picture (H.264/AVC 
only) as the picture type. Using this function also enables 
chapter specification.

Specifying the rate reassignment calculation 
range (CS Disable)
You can specify ranges in advance for which automatic rate 
adjustment will be disabled. If you perform rate adjustment 
(Weight Info) while the size for Reserve Space is set to 0, the 
rate is automatically adjusted to keep the entire target size at 
a certain level. If there is an area for which you do not want 
to change the rate, specify CS Disable in advance to exclude 
this area from the range of automatic rate adjustment.
As the CS Disable setting takes highest priority, other 
customizations will be disabled in ranges for which CS 
Disable is configured.

Specifying the progressive mode (Progressive)
When encoding interlace sources, you can specify still 
images and scenes with no motion to be encoded in 
progressive mode.

Setting scene change detection (Scene Change)
When there is a high amount of change in brightness in a 
scene from an animated source, for example, a large number 
of I pictures or IDR pictures (H.264/AVC only) may be 
inserted due to the frequent scene changes detected. This 
may result in a decrease in picture quality. To improve the 
picture quality in this case, specify the range that contains 
excessive amounts of scene change and disable scene change 
detection for it.

Setting the low pass filter (Low Pass Filter)
Block noise may occur when you encode sources that 
include grain noise or high-frequency components at bit 
rates of 10 Mbps or below. In this case, you can encode 
while removing these high-frequency components by 
applying this filter, and thereby reduce block noise.

Setting the noise removal filter (De-Noise Filter)
Apply this filter to remove noise while encoding sources that 
include camera noise.

Setting the banding removal filter (De-Band Filter)
Apply this filter to reduce banding while encoding sources in 
which banding occurs.

For H.264/AVC

Changing deblocking filter (Deblocking Filter)
The deblocking filter is used to reduce the block distortion 
that occurs when pictures are encoded.
You can change the value of the deblocking filter for each 
picture.

Changing the DCT size selection method (DCT 
size)
You can change the DCT size selection method for each 
picture (only when encoding has been done using High 
Profile).

Changing the scaling list (Scaling List)
You can change the scaling list for each picture.
Select one from the several scaling lists that have been 
registered as preset values.
Also, you can use user data that has been edited.

Changing the GI mode (Gradation Improvement 
Mode)
You can change the ON/OFF of Gradation Improvement for 
each picture.

Changing MBRC (Macro Block Rate Control)
You can change the ON/OFF of MBRC for each picture.
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Changing Refreshing Suppress
You can change the ON/OFF of Refreshing Suppress for 
each picture.

Changing Trailing Suppress
You can change the ON/OFF of Trailing Suppress for each 
picture. 

Specifying the weight control (Weight Adjust)
You can add weight to a specified range for bit rate 
assignment, then reencode. This enables you to change or 
adjust the bit rate assignment.

Notes

• For 1 PASS CBR Angle Unit, the customization functions 
cannot be used.

• For 1 PASS VBR Angle Unit, all customization functions 
except Weight adjustment can be used.

• For Multi Angle Angle Unit, the function to specify 
picture type cannot be used.

For MPEG-2

Adjusting the bit rate assignment weight (Weight 
Adjust)
When performing bit rate reassignment, you can add weight 
to a particular range, and adjust the bit rate for each frame of 
that range. With 1 being the base level of weight coefficient 
(Rate Adjust: 0.1 to 10), more bit rate is assigned if the value 
is larger than the base level, or less bit rate is assigned if the 
value is smaller than the base level. Even if you try to 
increase the bit rate, if there are restrictions on VBV buffer 
or maximum bit rate, the bit rate may not be raised beyond a 
certain value. Also, because the number of bits assigned to 
the entire video is a constant value, note that raising the bit 
rate of a certain range means dropping the bit rate of other 
areas.
If you select Keep Rate Mode, encoding will be performed 
at fixed rate.

Adjusting QMatrix (QMatrix)
By increasing QMatrix, you can drop the high range 
component of images with high level of encoding difficulty 
where bit rate control is difficult, so that bit rate control 
becomes easy.
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6-3-4 Customization Screen

a Customization control area

Timecode scale
Select a display unit for graduations in the graph display 
area.

Graduation width
Adjust the display width of one graduation.
Moving it to the left reduces the width while moving it to the 
right increases the width.

Start
Text box for input or display of the start position

End
Text box for input or display of the end position

Auto Decoding
When this check box is selected, the image at the current 
position appears automatically.

[Result View] button
Register the selected range as a clip for Result View.
When registration is finished, the clip is added to the clip list 
in the Result View window. Registration may take time to 
finish.

[Undo] button/ [Redo] button
Use these two buttons to cancel the previous operation, or 
cancel the previous Undo operation.
Up to 30 customization changes can be saved, and the 
operation can be canceled before Update is performed.

[Clear] button
Cancel all customization changes and return to the state 
when the data is loaded.

[Update] button
Confirm the customization changes made.

[TC] button/ [FR] button (graduation display)
Specify whether to display using timecode or relative frame 
number.

Timecode or relative frame number is displayed in every 10 
graduations.
Clicking the graduation displays the Mark setup/delete 
menu.

Add Mark: Set up a Mark (Customize) point.
Delete Mark: Delete all Mark (Customize) points that have 
been set up.

Shortcut keys

a Customization control area

b Customization setting area

c Customization information area

Shortcut key Description

Home Jump to Start

F3 Rewind

F1 Step Backward

Space or Ctrl + P Play / Pause

F2 Step Forward

F4 Fast Forward

End Jump to End

+ Increase the playback speed.

– Decrease the playback speed.

Esc Cancel the customization range.

Ctrl + D Switch between Direction FW and BW.

Ctrl + Space Set a mark.

Ctrl + T Display the timecode.

Ctrl + F Display the relative frame number.

Ctrl + C Toggle the review display (Encode/Source).

Ctrl + L Shift focus to the track bar in review display.

Ctrl + S Shift focus to toggling the review display.

Alt + J Jump

Alt + N Undo

Alt + R Redo

Alt + C Clear

Alt + U Update

Alt + E Entry

Alt + P Prev (Move to the previous access point.)

Alt + X Next (Move to the next access point.)

Ctrl + t Move to the next frame.
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b Customization setting area

Display or specify information for encoding parameters.

Information display
Display the customization range applied to the encoding 
parameters. Also, pointing the mouse to a parameter’s 
customization range displays the value of the setting.
• For H.264/AVC

Deblocking Filter: Green
DCT Size: Aqua
Scaling List: Pink
GI Mode (Gradation Improvement Mode): Purple
MBRC (Macro Brock Rate Control): Red
Refreshing: Orange
Trailing: Yellow
Low Pass Filter: Gray (light)
De-Noise Filter: Gray (medium)
De-Band Filter: Gray (dark)

• For MPEG-2
QMatrix: Green
Low Pass Filter: Gray (light)
De-Noise Filter: Gray (medium)
De-Band Filter: Gray (dark)

Access point
Display frame specified in access point in a yellow line.

CS Disable (customization prohibited)
Display range of prohibited customization in red line, on 
the green line of Encode area.

Picture Type
Display the following line on the scene with picture type 
changed.
If IDR picture is changed: Orange line
If I picture is changed: Blue line

New setting
After a range is specified, clicking the specified range 
displays a menu. Select a parameter you want to set up, then 
perform the setting operation.

If a range is not specified, right-clicking it displays a menu.

From the menu, select a parameter and the customization 
setting window appears.

Change or delete
If you click the specified range, the customization setting 
window appears so that you can change or delete parameters.

c Customization information area

Difficulty/PD
The graph indicates the encoding difficulty of pictures in the 
entire title.
During PD selection, a graph appears to show the Inverse 2-
3 Pull Down pattern.

Shift + t Move forward 1 sec.

Alt + t Move forward 10 sec.

Ctrl + Shift + t Move forward 1 min.

Ctrl + T Move to the previous frame.

Shift + T Move back 1 sec.

Alt + T Move back 10 sec.

Ctrl + Shift + T Move back 1 min.

Ctrl + I Set the start point as the timecode for the line 
cursor.

Ctrl + O Set the end point as the timecode for the line 
cursor.

Shortcut key Description



70 6-3 Customization Review

Chapter 6 Encoding

How to read the graph during Pulldown Pattern 
display

Yellow line: Means Interlace (pattern could not be 
detected).

Green line: Has the following meanings depending on 
the length of the line.

AA short
BB
BC
DD long
CD (dummy frame)

White line: The type of the pattern is shown in the left 
column of the graph.

Weight Adjust
This is a display box for changing or adjusting the bit rate 
assignment. A green graph appears and you can change the 
range from 1 to 20. 
The default weight is 10 indicating 100%. If you use a value 
larger than 10, you can assign more bit rate to the specified 
range. If you use a value smaller than 10, the bit rate 
assigned becomes smaller.

If you select Auto Customize, the Auto Customize function 
is executed when reencoding is performed. The range 
appears in blue. 
If you select Upper Limit, the specified range is encoded 
with an upper limit. The range appears in purple.
If you select Fade In or Fade Out, the weight is gradually 
assigned according to the fade in or fade out. The Fade In 
range appears in orange, and the Fade Out range appears in 
pink.

z Hint

Because the minimum unit for reencoding is RAP-IDR 
interval, it is more effective to set the adjustment range 
to RAP-IDR interval and then adjust the weight.

Note

It can be selected only when encoding is done using 2 Pass 
VBR.

Level (data size display area)
Data Size (result) and Initial Data Size (initial assignment) 
(conversion to bytes) appear as line graphs.

Data Size: Green
Initial Data Size: Aqua

Auto Adjust QP
QP (Quantize Parameter) displays the picture that has been 
adjusted automatically.

z Hint

While there are cases where the picture is adjusted using 
special conditions, it does not appear in normal 
encoding.

High Distortion
Display picture with high distortion rate in the encoding 
result.

Low Occupancy
Display picture where there is no leeway in the occupancy of 
the buffer.

DBF Alpha
Display the value of the α coefficient of the deblocking filter 
for each picture.

DBF Beta
Display the value of the ß coefficient of the deblocking filter 
for each picture.

6-3-5 Performing Customization (for 
H.264/AVC)

To specify a range for customization

Using the mouse

1 Click the position that you want to set as the start point.

The line cursor appears at the start point.

2 Click the position that you want to set as the end point.

The line cursor appears at the end point.
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To cancel the specified point
Right-click or press the Escape key.

Notes

• The following restrictions apply when you specify a 
customization range.

• For the following settings, the range start point and 
end point must be RAP-IDR picture.
• Refreshing Suppress
• Trailing Suppress
• CS Disable
• Upper Limit
• Retake
• User Define of Scaling List
• Scene Change OFF

• For 2-3 pulldown titles, the range start point and end 
point of dummy frame cannot be specified.

• To specify the last frame displayed as the end point, 

perform the procedure described in the following 

section “Using keyboard.”

• If RAP-IDR exists in the ranges specified by 

Refreshing Suppress and Trailing Suppress, 

customization items (deblocking filter, DCT Size, 

etc.) that cross over to RAP-IDR cannot be set up.

Using the keyboard

1 Click the Start text box

The Time Code window appears.

2 Enter the start point’s timecode using the keyboard, or 
change the value using the [Q] and [q] keys or the 
wheel of a wheel mouse, then click the [OK] button.

The Time Code window appears.

3 Enter the end point’s timecode using the keyboard, or 
change the value using the [Q] and [q] keys or the 
wheel of a wheel mouse, then click the [OK] button.

To change the deblocking filter (Deblocking 
Filter)

1 Specify a range to use for changing the deblocking 
filter.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Deblocking Filter.

ON: Use the deblocking filter. When you click the 
Setting area, the Deblocking Filter Setting window 
appears so that you can specify Deblocking Alpha and 
Deblocking Beta. 
OFF: Do not use the deblocking filter.

The changed range appears in the green color.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Deblocking Filter, the 
customization setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.



72 6-3 Customization Review

Chapter 6 Encoding

Value
Specify whether to use the deblocking filter. You can select 
ON (use) or OFF (not to use).

DBF Alpha
You can specify the alpha coefficient offset of a deblocking 
filter, within a range from –6 to +6.

DBF Beta
You can specify the beta coefficient offset of a deblocking 
filter, within a range from –6 to +6.

[Add] button
Apply the deblocking filter to the specified range.

[Update] button
Update the deblocking filter information if you have edited 
the existing deblocking filter information.

[Split] button
Split the existing range using the specified timecode.

To change the DCT size selection method 
(DCT size)

1 Specify a range to use for changing the DCT size 
selection method.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select DCT Size.

4 Select a DCT size.

The changed range appears in the aqua color.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select DCT size, the customization 
setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Select a DCT size.

[Add] button
Apply the DCT size to the specified range.

[Update] button
Update the DCT size information if you have edited the 
existing DCT size information.

[Split] button
Split the existing range using the specified timecode.

To change the scaling list (Scaling List)

1 Specify a range to use for changing the scaling list.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Scaling List.

4 Select a scaling list.

The changed range appears in the pink color.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Scaling List, the customization 
setting window appears.
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Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Select a scaling list.

Scaling List ID
Select Scaling List ID when User Define is selected in 
Value.

[Add] button
Apply the scaling list to the specified range.

[Update] button
Update the scaling list information if you have edited the 
existing scaling list information.

[Split] button
Split the existing range using the specified timecode.

To change the GI mode (Gradation 
Improvement Mode)

1 Specify a range to use for changing the G1 mode.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Gradation Improvement.

ON: Use GI mode.
OFF: Do not use GI mode.

The changed range appears in the purple color.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Gradation Improvement, the 
customization setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Specify whether to use the GI mode. You can select ON 
(use) or OFF (not to use).

[Add] button
Apply the GI mode to the specified range.

[Update] button
Update the GI mode information if you have edited the 
existing GI mode information.

[Split] button
Split the existing range using the specified timecode.

Changing Macro Block Rate Control

1 Specify a range to change Macro Block Rate Control.

2 In the Setting area, click within the specified range.

A menu appears.
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3 From the menu, select Macro Block Rate Control.

ON: Use Macro Block Rate Control.
OFF: Do not use Macro Block Rate Control.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Macro Block Rate Control, the 
customization setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Select whether to use Macro Block Rate Control (ON) or not 
(OFF).

[Add] button
Apply Macro Block Rate Control to the specified range.

[Update] button
Update the Macro Block Rate Control information when an 
existing Macro Block Rate Control is edited.

[Split] button
Split the existing range using the specified timecode.

Changing Refresh Suppress

1 Specify a range to change Refresh Suppress.

Only RAP-IDR picture can be specified in the start 
point and end point.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Refresh Suppress.

ON: Use Refresh Suppress.
OFF: Do not use Refresh Suppress.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Refresh Suppress, the 
customization setting window appears.

Start Time Code
Specify a start point to use for customization.
Only RAP-IDR picture can be specified.

End Time Code
Specify an end point to use for customization.
Only RAP-IDR picture can be specified.

Value
Select whether to use Refresh Suppress (ON) or not (OFF).

[Add] button
Apply Refresh Suppress to the specified range.

[Update] button
Update the Refresh Suppress information when an existing 
Refresh Suppress is edited.

[Split] button
Split the existing range using the specified timecode.
Only RAP-IDR picture can be specified.
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Changing Trailing Suppress

1 Specify a range to change Trailing Suppress.

Only RAP-IDR picture can be specified in the start 
point and end point.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Trailing Suppress.

Animation: Use the algorithm optimized for animation.
Normal: Use the algorithm optimized for general titles.
OFF: Do not use Trailing Suppress.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Trailing Suppress, the 
customization setting window appears.

Start Time Code
Specify a start point to use for customization.
Only RAP-IDR picture can be specified.

End Time Code
Specify an end point to use for customization.
Only RAP-IDR picture can be specified.

Value
Select to use the animation algorithm of Trailing Suppress 
(Animation), the algorithm for general titles (Normal), or do 
not use it (OFF).

[Add] button
Apply Trailing Suppress to the specified range.

[Update] button
Update the Trailing Suppress information when an existing 
Trailing Suppress is edited.

[Split] button
Split the existing range using the specified timecode.
Only RAP-IDR picture can be specified.

To specify the bit rate reassignment 
calculation range (CS Disable)

1 Specify the range that you do not want to use the 
AutoCustomize function to perform automatic bit rate 
adjustment.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select CS Disable, then click ON.

A red line appears in the Weight area and the selected 
range is excluded from rate adjustment.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select CS Disable, the customization 
setting window appears.

Start Time Code
Specify a start point to use for customization.
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End Time Code
Specify an end point to use for customization.

Value
Specify whether to use CS Disable. You can select ON (use) 
or OFF (not to use).

[Add] button
Apply CS Disable to the specified range.

[Update] button
Update the CS Disable information if you have edited the 
existing CS Disable information.

[Split] button
Split the existing range using the specified timecode.

To specify a picture type (Picture Type)

1 Specify a timecode for changing the picture type.

z Hint

Specify the same timecode for both the start point 
and end point.

2 Click the Setting area.

A menu appears.

3 From the menu, select IDR or I.

An orange (IDR) or blue (I) line appears in the Setting 
area.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Picture Type, the customization 
setting window appears.

Start Time Code
Specify the timecode of the point where you want to change 
the picture type.

Value
Select a picture type.

[Add] button
Apply the picture type to the specified range.

[Update] button
Update the picture type information if you have edited the 
existing picture type information.

Specifying the progressive mode 
(Progressive)

1 Specify a range for the progressive mode.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Progressive.

ON: Use the progressive mode.
OFF: Do not use the progressive mode.

If you right-click the Setting area without specifying a range, 
a menu appears.
From the menu, if you select Progressive, the customization 
setting window appears.
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Start Time Code
Specify a start point to use for customization.
Only RAP-IDR picture can be specified.

End Time Code
Specify an end point to use for customization.
Only RAP-IDR picture can be specified.

Value
Select whether to use progressive mode (ON/OFF).

[Add] button
Apply progressive mode to the specified range.

[Update] button
Updates progressive mode information when existing 
information is edited.

To apply weight control (Weight Adjust)

1 Specify a range for adjusting the weight.

2 In the Weight area, use the mouse to drag the red line in 
the specified range up or down to change its value.

3 Double-click to accept the value.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Weight Adjust, the 
customization setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Weight
Select a weight. (Available during Normal)

Normal
Apply the selected weight.

Upper Limit Mode
Perform encoding on the specified range, using the 1 PASS 
CBR mode (fixed bit rate). 
The bit rate is the Max Bit Rate set in the Size tab of Project 
Manager. 
The range customized in Upper Limit Mode cannot be 
customized further.

Section Specify (Auto Customize)
Perform automatic customization on the specified range.

Fade In
Gradually assign weight according to the fade in of the 
specified range. In addition, the first frame of the specified 
range becomes an IDR picture.

Fade Out
Gradually assign weight according to the fade out of the 
specified range.

[Add] button
Apply the weight to the specified range.

[Update] button
Update the weight information if you have edited the 
existing weight information.
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[Split] button
Split the existing range using the specified timecode.

Changing Scene Change Detection Settings

1 Specify the range for which you want to disable scene 
change detection.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Scene Change > OFF.

The selected range appears in gray in the Weight area.

If you right-click the Setting area without specifying a range, 
a menu appears.
If you select Scene Change > OFF from the menu, the 
Customize Setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Set scene change detection to OFF.

Note

This setting can only be configured if encoding was 
performed after setting scene change detection ON in the 
encoding parameters. Once you select OFF for this setting, 
you cannot set it to ON again.

[Add] button
Disable scene change detection for the specified range.

To apply the low pass filter (Low Pass Filter)

1 Specify the range to which you want to apply the low 
pass filter.

2 On the Filter line in the Setting area, click within the 
specified range.

A menu appears.

3 From the menu, select the filter strength.

Depending on the video format, the filter mode will be 
Grain Mode, CG Mode, HD Mode, or SD Mode. Select 
from the following strengths for each mode.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

z Hint

The CG Mode filter is effective for CG animation 
sources.

If you right-click the Filter line in the Setting area without 
specifying a range, a menu appears. If you select Low Pass 
Filter from the menu, the Customize Setting window 
appears.
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Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Select a strength for the low pass filter.

[Add] button
Apply the low pass filter to the specified range.

[Update] button
Update low pass filter information when existing 
information is edited.

[Split] button
Split the existing range using the specified timecode.

To apply the noise removal filter (De-Noise 
Filter)

1 Specify the range to which you want to apply the de-
noise filter.

2 On the Filter line in the Setting area, click within the 
specified range.

A menu appears.

3 From the menu, select the filter strength.

Depending on the video format, the filter mode will be 
Grain Mode, CG Mode, HD Mode, or SD Mode. Select 
from the following strengths for each mode.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.

Strong: Apply the filter at high strength.

z Hint

The CG Mode filter is effective for CG animation 
sources.

If you right-click the Filter line in the Setting area without 
specifying a range, a menu appears. If you select De-Noise 
Filter from the menu, the Customize Setting window 
appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Select a strength for the de-noise filter.

[Add] button
Apply the de-noise filter to the specified range.

[Update] button
Update de-noise filter information when existing 
information is edited.

[Split] button
Split the existing range using the specified timecode.

To apply the banding removal filter (De-Band 
Filter)

1 Specify the range to which you want to apply the de-
band filter.
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2 On the Filter line in the Setting area, click within the 
specified range.

A menu appears.

3 From the menu, select the filter strength.

Depending on the video format, the filter mode will be 
Grain Mode, CG Mode, HD Mode, or SD Mode. Select 
from the following strengths for each mode.
Weak: Apply a filter for sources with small amounts of 
banding.
Strong: Apply a filter for sources with large amounts of 
banding.

z Hint

The CG Mode filter is effective for CG animation 
sources.

If you right-click the Filter line in the Setting area without 
specifying a range, a menu appears. If you select De-Band 
Filter from the menu, the Customize Setting window 
appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Select a strength for the de-band filter.

[Add] button
Apply the de-band filter to the specified range.

[Update] button
Update de-band filter information when existing information 
is edited.

[Split] button
Split the existing range using the specified timecode.

6-3-6 Performing Customization (for 
MPEG-2)

The following is an example using Customize Type to make 
change.

If block noise or noise close to it occurs

Increase the value of Rate Adjust. The standard value is 10.

If picture quality in some areas deteriorates 
significantly during scene change

At S-Change, specify the picture at scene change and change 
it to I picture.

To apply weight control (Weight Adjust)

1 Specify a range for adjusting the weight.

2 In the Weight area, use the mouse to drag the red line in 
the specified range up or down to change its value.

3 Double-click to accept the value.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Weight Adjust, the 
customization setting window appears.
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Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Weight
Select a weight. (Available during Normal)

Normal
Apply the selected weight.

Upper Limit Mode
Perform encoding on the specified range, using 1 PASS 
CBR mode (fixed bit rate).
The bit rate is the Max Bit Rate set in the Size tab of Project 
Manager.
The range customized in Upper Limit Mode cannot be 
customized further.

Keep Rate Mode
Perform encoding on the specified range while maintaining 
a rate that is close to the Max Bit Rate set in the Size tab of 
Project manager.

Section Specify (Auto Customize)
Perform automatic customization on the specified range.

Fade In
Gradually assign weight according to the fade in of the 
specified range. In addition, the first frame of the specified 
range becomes an IDR picture.

Fade Out
Gradually assign weight according to the fade out of the 
specified range.

[Add] button
Apply the weight to the specified range.

[Update] button
Update the weight information if you have edited the 
existing weight information.

[Split] button
Split the existing range using the specified timecode.

To specify the bit rate reassignment 
calculation range (CS Disable)

1 Specify the range that you do not want to use the 
AutoCustomize function to perform automatic bit rate 
adjustment.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select CS Disable, then click ON.

A red line appears in the Weight area and the selected 
range is excluded from rate adjustment.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select CS Disable, the customization 
setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.
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Value
Specify whether to use CS Disable. You can select ON (use) 
or OFF (not to use).

[Add] button
Apply CS Disable to the specified range.

[Update] button
Update the CS Disable information if you have edited the 
existing CS Disable information.

[Split] button
Split the existing range using the specified timecode.

Adjusting QMatrix

1 Specify a range for adjusting QMatrix.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select QMatrix.

4 Select a value or defined name of QMatrix.

The adjusted range appears in green.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select QMatrix, the customization 
setting window appears.

Start Time Code
Specify the start point of customization.

End Time Code
Specify the end point of customization.

Value
Select a value or defined name of QMatrix.

[Add] button
Apply QMatrix to the specified range.

[Update] button
When existing QMatrix information is modified, update the 
QMatrix information.

[Split] button
Split the existing range using the specified timecode.

Specifying the progressive mode 
(Progressive)

1 Specify a range for the progressive mode.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Progressive.

ON: Use the progressive mode.
OFF: Do not use the progressive mode.

If you right-click the Setting area without specifying a range, 
a menu appears. 
From the menu, if you select Progressive, the customization 
setting window appears.
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Start Time Code
Specify a start point to use for customization.
Only RAP-IDR picture can be specified.

End Time Code
Specify an end point to use for customization.
Only RAP-IDR picture can be specified.

Value
Select whether to use progressive mode (ON/OFF).

[Add] button
Apply progressive mode to the specified range.

[Update] button
Updates progressive mode information when existing 
information is edited.

Changing Scene Change Detection Settings

1 Specify the range for which you want to disable scene 
change detection.

2 In the Setting area, click within the specified range.

A menu appears.

3 From the menu, select Scene Change > OFF.

The selected range appears in gray in the Weight area.

If you right-click the Setting area without specifying a range, 
a menu appears.
If you select Scene Change > OFF from the menu, the 
Customize Setting window appears.

Start Time Code
Specify a start point to use for customization.

End Time Code
Specify an end point to use for customization.

Value
Set scene change detection to OFF.

Note

This setting can only be configured if encoding was 
performed after setting scene change detection ON in the 
encoding parameters. Once you select OFF for this setting, 
you cannot set it to ON again.

[Add] button
Disable scene change detection for the specified range.

6-3-7 Reencoding

1 After customization is completed, click the [Update] 
button.

2 Click the [Entry] button.

The Project Monitor screen appears.

For details on the Project Monitor screen, refer to “6-
2-6 Monitoring Encoding (Project Monitor Screen),” 
page 62.
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3 Click the [Start] button.

Repeat this procedure until a satisfactory picture quality is 
obtained.

To abort encoding
From the Encode window, click the [Abort] button.

To undo the previous operation
Click the [Undo] button.

To return the customized value back to its default
Click the [Clear] button.

To jump to the display position

You can use the following procedure to jump to the position 
of an encode unit displayed in the display box.

Double-click the position to jump to from the Jump List.
The specified position appears in the display box.

Note

In the Jump List window, you can delete only points 
registered using the [Mark] button during review or points 
registered using the Mark operation during customization.

To select items for displaying in the Jump List

1 In the Encode Manager window, select Jump List 
Setting from the Option menu.

The Jump List Setting window appears.

2 Select the check boxes of items you want to display in 
the Jump List.

3 Click the [OK] button.

The Jump List Setting window closes, and the Encode 
Manager window returns.

Data displayed in the Jump List

When Jump List is called, the following data appears.

Display of 

Jump List 

Setting

Mode 

display of 

Jump List

Display of Jump List Time

Access Point Access Point Access point specified in the Input 
Access Point window

Weight Weight StartTC customized at Weight on 
the Customize tab

CS Disable CS Disable StartTC customized at CS Disable 
on the Customize tab

Deblocking 
Filter

Deblocking 
Filter

StartTC customized at Deblocking 
Filter on the Customize tab

Scaling List Scaling List StartTC customized at Scaling List 
on the Customize tab

Gradation 
Improvement

Gradation 
Improvement

StartTC customized at Gradation 
Improvement on the Customize tab

Macro Block 
Rate Control

Macro Block 
Rate Control

StartTC customized using MBRC 
on the Customize tab

Refreshing 
Suppress

Refreshing 
Suppress

StartTC customized using 
Refreshing on the Customize tab

Trailing 
Suppress

Trailing 
Suppress

StartTC customized using Trailing 
on the Customize tab

Picture Type Picture Type StartTC customized at Picture 
Type on the Customize tab.

Auto 
Customize

Auto 
Customize

StartTC customized at Auto 
Customize on the Customize tab.

User (Preview) User 
(Customize)

Timecodes for points where the 
Mark button is clicked during the 
review process.

User 
(Customize)

User 
(Customize)

Timecodes for points where the 
Mark button is clicked during the 
customization process.
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6-3-8 About Auto Customize
If you select the Auto Customize check box on the Encode 
tab, encoding is performed on the candidate with its weight 
changed according to the setting. 
The range (where auto customization is determined to be 
necessary according to the setting and then executed) 
appears as a blue line in the Weight area.

Selecting a customization candidate

1 While in the Encode Manager window, select Auto 
Customize from the Information menu.

The Auto Customize window appears.

In the list of the Detail Information block, the weight 
candidates encoded using Auto Customize appear.

2 Select a customization candidate from the list of the 
Detail Information block.

3 In the Selection block, select Temporary or 
Determinate.

Temporary: Select it if you want to check the picture 
quality using the Review tab.
Determinate: Select it if you want to finalize the 
candidates.

4 Click the [Set] button.

5 Click the [OK] button.

Note

When you select Determinate in the Selection block and then 
close the Auto Customize window, the operation cannot be 
cancelled. Also, the finalized range is handled in the same 
way as normal weight adjustment.

6-3-9 Saving Check Point
You can save the customization state of a point in time as a 
check point. Furthermore, after adding customization, you 
can restore it back to the state of the saved check point.

Saving a check point

1 On the Customize Review window, select Check Point 
from the Information menu.

The Check Point dialog box appears.

2 In Mode, select Add and then click the [Add] button.

The customization state at the current time is saved as a 
check point.

In Mode, if you select Edit, you can edit the memo of the 
check point. After editing is finished, click the [Update] 
button.

Restoring check point state

1 In the Check Point dialog box, select Set from Mode.

2 From the check point list, select a check point to return 
to, and then click the [Set] button.
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6-3-10 Performing Retake
When you edit a section of the source after encoding, you 
can perform encoding for just that edited range. The encoded 
stream will replace the previous stream and be combined 
after finalization.

Notes

• The range that can be replaced is RAP IDR interval.
• This function cannot be used for projects in which 

pulldown detection was performed.
• Simultaneous encoding for customize and retake is not 

supported.
• If customization settings have been configured for an 

interval specified for retake, the customization settings 
will be cleared.

• If you want to retake an interval for which progressive 
mode has been enabled, be sure to set progressive mode to 
OFF before configuring retake.

Determining the range to be replaced

1 Open the Customize Review window.

2 Find the RAP IDR picture immediately preceding the 
beginning of the edit point, and write down the 
timecode, as it will be used as the start point for 
replacement.

3 Find the RAP IDR picture immediately proceeding the 
end of the edit point, and write down the timecode, as it 
will be used as the end point for replacement.

4 Close the Customize Review window.

Capturing the source for the replacement 
range

1 Open the Capture Control window.

2 Capture the interval that contains the range to be 
replaced.

3 Close the Capture Control window after capture is 
finished.

Note

Be sure to specify a capture interval that is longer than 
the range to be replaced.

Performing retake

1 Open the Customize Review window.

2 Select Retake Setting from the Encode menu to display 
the Retake Setting window.

3 In the Retake Range block, specify the start point for 
replacement in Start Time Code, and specify the end 
point for replacement in End Time Code.

4 Specify the newly captured source file in Source 
Filename.

5 In the Setting Range block, specify the start point for 
the source file in Start Time Code, and specify the end 
point for the source file in End Time Code.

6 Click the [OK] button to close the window.

z Hint

Be sure that the lengths specified for Retake Range 
and Setting Range are the same.

Reencoding

1 Click the [Update] button.

2 Click the [Entry] button.

The Project Monitor screen opens.

For details on the Project Monitor screen, refer to 
“6-2-6 Monitoring Encoding (Project Monitor 
Screen),” page 62.
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z Hint

To perform retake after finalizing is finished, undo 
the finalize procedure.

Notes

• If the source file has been significantly modified, 
optimal picture quality may not be obtained.

• This feature is not compatible with fast two-pass 
encoding.

6-3-11 Finalizing a Project
Use the following procedure to finalize a project where 
encoding has been completed.

1 From the Project Manager, select a project where 
encoding has been completed.

2 From the Finalize menu, select Entry.

The Project Monitor screen appears.

For details on the Project Monitor screen, refer to “6-
2-6 Monitoring Encoding (Project Monitor Screen),” 
page 62.

3 Click the [Start] button.

The Finalize operation starts.
The progress status of Finalize appears on the Project 
Monitor screen.

Undoing a finalize procedure

You can return projects that have been finalized to their 
original states.

1 Select a project that has been finalized in Project 
Manager.

2 Right-click the mouse, and select Undo from the menu 
that appears.
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6-4 Result View Registration

You can view and compare the source image and encode image in a split screen display.
You can view the comparison in the Result View window, but range specification for the compared clips is performed in the 
Customize screen.

6-4-1 Customize Screen

To specify a range for Result View registration

Using the mouse

For details, refer to “6-3-5 Performing Customization (for 
H.264/AVC),” page 70.

1 Click the position you want to set as the start point.

2 Click the position you want to set as the end point.

3 Click the Result View registration button.

To cancel the specified point
Right-click or press the Escape key.

Using the keyboard

1 Click the Start text box.

2 The Time Code window appears.

Enter the start point’s timecode using the keyboard, or 
change the value using the R and r keys or the wheel of 
a wheel mouse, then click the [OK] button.

3 Click the Result View registration button.

Creation of the comparison file begins when you click 
the Result View registration button.

Notes

• Due to the time it takes to create a comparison file, it may 
take time for the file to be registered to the clip list in the 
Result View window after clicking the Result View 
registration button.

• A comparison file requires approximately 1.5 TB (when 
the video format is 1920 × 1080/59.94i) of capacity for a 
1-hour clip file.

Result View registration button
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Chapter 7 Slideshow

7-1 Chapter Outline

This chapter describes still image encoding for slideshow as 
well as slideshow review.

7-2 Starting and Quitting Slide 
Show Encoder

7-2-1 Starting Slide Show Encoder
Click the Slide Show button in Launcher.

Slide Show Encoder starts.

7-2-2 Quitting Slide Show Encoder
Click the  button on the window, or select Close from the 
File menu.
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7-2-3 Slide Show Encoder Screen

a Menu bar

b Still image file list

From the System Setup window, use Input Folder > Still 
Image File to display a list of still image files in the specified 
folder.
The following types of files are displayed.
TIFF, PNG, JPEG, BMP, GIF

c Project list

From the System Setup window, use Input Folder > XML 
file (Slide Show) to display a list of specified project file for 
still image encoding.

[New] button
Create a new project.

[Edit] button
Edit an existing project.

[Delete] button
Delete a project.

[Cancel] button
Cancel project editing.

d Project window

Display the project setting screen, encoding monitor, or 
review screen.

b Still image file list

c Project list

d Project window

a Menu bar

Menu bar Command Description

File Close Exit Slide Show Encoder.

Project Select Path Select a folder containing projects 
saved. All jobs stored in the selected 
folder are displayed in the project list.

Select File Select a project file and open it.

New Create a new project.

Edit Edit a project selected from the project 
list.

Delete Delete a project selected from the 
project list.

Save Update the displayed settings and save 
the project.

View Refresh Update display of the screen to its latest 
status.

Encode Entry Register a project for encoding.

Finalize Browsing 
Unit Single 
BS

Start finalization for a project encoded 
using the Single BS settings of the 
browsing unit.

Review Force SDI 
Field Mode

Specify the Force SDI Field Mode. SD 
source is output with the top field first, 
and HD source is output with the 
bottom field first.

Renderer Output review pictures to the monitor 
connected to the video output board of 
the control PC.
Setup: Specify the Renderer 
combination.
Reset: Reset the setting.

Window Project Display the project setting screen in the 
project window.

Monitor Display the encoding monitor in the 
project window.

Help Version Display the version, copyright, and 
other information about this software.

Menu bar Command Description
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7-3 Creating and Encoding a 
Project (Project Setting Tab)

7-3-1 Creating a Project

1 Click the [New] button on the project list, or select New 
from the Project menu.

The Project tab appears.

2 Use the Project tab to specify the project information.

Specify the basic information of the slideshow, such as 
content name, slideshow type, and codec format.

3 Click the [Update] button.

The project information is updated.

4 Use the Still Picture tab or Movie tab to specify the 
encoding parameters.

Depending on the settings in the Slide Show Setting 
block of the Project tab, the tab for performing the 
settings will be different. 
Also, depending on the encoding type specified on the 
Project tab, the settings on each tab will be different.

5 Use the Information tab to specify the source for 
display in the slideshow.

Drag and drop the source, specify the duration, and then 
click the [Add] button.
You can specify different encoding parameters for each 
source.

6 Repeat step 5 according to the number of sources to 
display.

7 Click the [Update] button at the bottom of the screen to 
update the project information.

8 Select Save from the Project menu to save the project.
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7-3-2 Setting up Basic Information of a Project (Project Tab)

a Project Information block

SENC XML File Pathname
Specify a pathname to use for saving a project (SENC.XML 
file). Enter a pathname directly, or click the Browse button 
to select a pathname.
In the folder specified as the destination to save, a folder 
with the content name entered in Content Name is created 
automatically and the project file (SEN.XML file) is stored 
in that folder.

Job ID
Enter the job ID of a job to create.

Content Name
Enter the content name of a project to create (within 255 
characters). 
A folder with the entered name is automatically created 
respectively at the location indicated by Project Data 
Pathname as well as Destination Pathname.

Filename Prefix
Enter the file name of a stream to save. The entered name is 
automatically added to the beginning of video stream file 
name.

Project Data Pathname
Specify a pathname for saving project data of a project to 
create. Enter a pathname directly, or click the Browse button 
to select a pathname. 
In the folder specified as the destination to save, a folder 
with the content name entered in Content Name is created 
automatically and the project data is stored in that folder.

Destination Pathname
Specify a pathname for saving stream of a project to create. 
Enter a pathname directly, or click the Browse button to 
select a pathname. 

In the folder specified as the destination to save, a folder 
with the content name entered in Content Name is created 
automatically and the stream file is stored in that folder.

b Slide Show Setting block

Slide Show Type
Specify the type of slideshow.

Slide Show Mode
Specify the slideshow mode.

c Common Setting block

Codec Class
Specify the encoding type (H.264/AVC, MPEG-2).

Aspect Ratio
Specify the aspect ratio.

Video Format
Specify the video format.

Field Order
Specify the field order.

Frame Rate
Specify the frame rate.

Profile Level
Specify the profile level.

[Update] button
Update the settings of the Project tab.

b Slide Show Setting block

c Common Setting block

a Project Information block
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7-3-3 Setting up Detailed Settings of 
Still Image Encoding (Still 
Picture Tab)

Average Bit Rate
Specify the average bit rate for still image encoding. 
(Maximum value is 40 Mbps.)

Maximum Bit Rate
Specify the maximum bit rate of still image encoding 
(maximum 40 Mbps).

Low Pass Filter
Configure the low pass filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

De-Noise Filter
Configure the de-noise filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

z Hint

The CG Mode filter is effective for CG animation 
sources.

Stream ID Generator
If this check box is selected, the bitmap file specified in 
System Setup is inserted.

H.264/AVC block
If H.264/AVC is selected in Codec Class, specify the 
encoding parameters.

Max Slice Num
Specify the number of slice.

M Pattern
Specify the M pattern.

DCT Size
Specify the DCT size selection method.

Scaling List
Specify the Scaling List.
When High Profile is selected, you can use a method where 
weight is added to each frequency component included in the 
image for encoding.

User Define
If User Define is selected in Scaling List, select the preset 
scaling list.

User Define ID
Select a User Define ID.

Deblocking Filter
Select it to enable the deblocking filter.

Deblocking Alpha / Deblocking Beta
Specify the coefficients α and β offset values of the 
deblocking filter.

Video Signal Type Present
Select it to include video signal information in the stream.

Colour Description
Specify whether to include color information in the stream.

Video Format
Specify the video format.

MPEG2 block

If MPEG2 is selected in Codec Class, specify the encoding 
parameters.

QMatrix
Specify QMatrix.

User Define
If User Define is selected in QMatrix, select the preset 
scaling list.

User Define ID
Select a User Define ID.
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7-3-4 Setting up Detailed Settings of 
Video Encoding (Movie Tab)

Encode Quality

Specify the quality of encoding.
Quality: The best picture quality can be obtained but 
encoding takes time.
Speed: The picture quality and encoding time both fall 
between Quality and Express.
Express: The picture quality is not as good as the other two 
modes, but we recommend this mode when prioritizing 
speed.
The default is Quality.

z Hint

If your focus is image quality, we recommend that you 
use the Quality mode to perform encoding.

Encode Style
Specify whether to encode using 2 passes (2 Pass VBR or 
Fast 2 Pass VBR) or 1 pass (1 Pass CBR or 1 Pass VBR 
(AVC encoding only)).

Low Pass Filter
Configure the low pass filter setting. The default setting is 
OFF.
Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

De-Noise Filter
Configure the de-noise filter setting. The default setting is 
OFF.

Depending on the video format, the filter mode will be Grain 
Mode, CG Mode, HD Mode, or SD Mode. Select from the 
following strengths for each mode.
OFF: Do not apply the filter.
Weak: Apply the filter at low strength.
Middle: Apply the filter at medium strength.
Strong: Apply the filter at high strength.

z Hint

The CG Mode filter is effective for CG animation 
sources.

Average Bit Rate
Specify the average bit rate for video encoding. (The 
maximum value is 400 × 100 kbps.)

Note

It cannot be set in 1 Pass CBR. When 1 Pass CBR is used, 
specify only Maximum Bit Rate.

Maximum Bit Rate
Specify the maximum bit rate for video encoding. (The 
maximum value is 400 × 100 kbps.)

Stream ID Generator
If this check box is selected, the bitmap file specified in 
System Setup is inserted.

H.264/AVC block

If H.264/AVC is selected in Codec Class, specify the 
encoding parameters.
For details on the parameters, refer to “6-2-3 Performing 
Detailed Settings of Encoding (Encode Parameter Tab in the 
Case of H.264/AVC),” page 56.

MPEG2 block

If MPEG2 is selected in Codec Class, specify the encoding 
parameters. 
For details on the parameters, refer to “6-2-4 Performing 
Detailed Settings of Encoding (Encode Parameter Tab in the 
Case of MPEG-2),” page 60.

7-3-5 Setting up Slide Information 
(Information Tab)

Add source (slide) for display in slideshow. 
To add source, drag and drop the source to Still Picture 
Filename or Source Filename. 
You can specify encoding parameters for each added source.
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Encode Mode
Specify the encoding mode.

Single BS: Generate joined streams.
Multi BS: Generate individual stream.

Still Image Source block

Select when adding still image as source of slideshow.

Still Picture Filename
Use one of the following methods to specify the file name of 
a still image file.
• Drag and drop from the tree area.
• Click the Browse button to select the file name.

[Parameter] button
Click this button when you want to specify encoding 
parameters for each source. 
The Slide Show Encode Parameter dialog box appears.
For details on parameters that can be specified, refer to “7-
3-2 Setting up Basic Information of a Project (Project 
Tab),” page 92.

Slide Show Duration
Specify the slideshow duration of the source to add.

Movie Source block

Select when adding video as source of slideshow.

Source Filename
Use one of the following methods to specify the file name of 
a video.
• Drag and drop from the tree area.
• Click the Browse button to select the file name.

[Parameter] button
Click this button when you want to specify encoding 
parameters of the source to add. 
The Movie Encode Parameter dialog box appears. 
For details on parameters that can be specified, refer to 
“6-2-3 Performing Detailed Settings of Encoding (Encode 
Parameter Tab in the Case of H.264/AVC),” page 56 or 

“6-2-4 Performing Detailed Settings of Encoding (Encode 
Parameter Tab in the Case of MPEG-2),” page 60.

Start Time Code / End Time Code
Specify the start timecode and end timecode of the source to 
add.

Duration
Display the duration calculated from values specified by 
Start Time Code and End Time Code.

Number of Source
Display the number of sources included in the slideshow.

Time Code
Display the timecode.

[Add] button
Add the settings to the source list.

[Update] button
Update the source currently selected from the source list 
with settings on the tab.

[Delete] button
Delete the source currently selected from the source list.

Source list
Display a list of sources added to the slideshow.

[Update] button
Update the project with the settings.
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7-4 Encoding Slideshow

1 From the Project list, select a project to encode.

2 Select Entry from the Encode menu.

The encoding monitor screen appears automatically.

3 Click the [Start] button.

Encoding starts. The encoding progress status appears 
on the encoding monitor screen.

Project monitor screen

Still Picture Encode tab
Register Still Picture projects for Timebased Slide Show and 
Browsable Slide Show.

Movie Encode tab
Register Still Movie for Browsable Slide Show or register 
Browsing Unit projects.

a Project list

Registered projects appear in the list.
The project status is indicated by the following icons.

: Target of execution

: Not target of execution

: Execution in progress

: Normal termination

: Abnormal termination or cancellation

Selected Data / All Data
Select whether to start processing the selected project only, 
or all projects.

[Delete] button
Delete the selected project.

[Disable] / [Enable] button
Disable or enable the selected project as target for execution.

[Reset] button
Reset the status of a project and specify it as target of 
execution.

v / V button
Move the project up or down.

[Start] button
Start the process.

Project list
Display registered projects in a list.
Contents Name: Content name
Order: Registered content of process
Status: Project status
Registration: Registration date and time
Start: Process start date and time
End: Process end date and time
Processing: Time elapsed in process
Remain: Estimated remaining time of process
Description: Details of process content

b Log display area c Information 
display area

a Project list
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b Log display area

Display process execution log.

c Information display area

7-5 Reviewing Slideshow

Review the slideshow after encoding is finished.

1 From the Project list, select a project with encoding 
finished.

2 From the Window menu, select Project.

The project setting screen appears.

3 Select the Review tab.

4 From the source list, select a source you want to review.

The selected image appears.

You can control Browsing Unit (Movie) by pressing 
Ctl+S (stop) or Ctl+P (play).
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Chapter 8 Creating Disc Images

8-1 Chapter Outline

This chapter describes how to create BD-ROM disc images 
using encoded video streams.

8-2 Starting and Quitting Disc 
Image Creator

8-2-1 Starting Disc Image Creator
Click the Disc Image Creator button in Launcher.

Disc Image Creator starts.

8-2-2 Quitting Disc Image Creator
Click the  button on the window, or select Exit from the 
File menu.

8-2-3 Disc Image Creator Screen (List 
Display Mode)

Menu bar

Menu bar Command Description

File Close Exit Disc Image Creator.

Edit Entry Add a project to the Progress screen, 
and begin creating disc images.

Audio 
Setting

Specify the audio file to be multiplexed 
with the video.

Project Delete Delete the selected project from the 
Progress screen.

All Delete Delete all projects from the Progress 
screen.

Control Start Start disc image creation.

Stop Stop disc image creation.

System Option Display the option settings screen.

Default 
Setting

Return settings to default 
configurations.

Window Detail Display/hide the Detail area.

Log Display/hide the Log area.
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8-3 Creating the Disc Images

8-3-1 Assigning Audio Files

1 Switch to list display mode.

2 Select the video stream to which the audio file will be 
assigned, and run Audio Setting from the Edit menu.

The Audio Setting screen appears.

3 Select the audio file.

4 Click the [OK] button.

z Hint

You can only assign WAV-format audio files. To use 
audio data captured during video capture, convert the 
data to WAV files using AVI to WAV Converter.

For details, refer to “2-2-4 AVI to WAV Converter,” 
page 15.

8-3-2 Option Setting
When Auto Start is selected, disc image creation starts 
automatically when the video stream is registered to the 
Progress list.

1 Run the Option command from the System menu.

The Option Setting screen appears.

2 Select the Auto Start check box.

3 Click the [OK] button to close the screen.

8-3-3 Registering Video Streams and 
Disc Image Creation

Select the video stream with which to create the disc image, 
and run Entry from the Edit menu.
You can also select the video stream, and run Entry from the 
right-click menu.

The selected video stream is registered to the Progress list, 
and disc image creation starts.
If Auto Start is not selected, start disc image creation by 
selecting Start from the Control menu.
The following folders are created when disc image creation 
starts, and disc images are stored as “IMAGE.img” under 
these folders.
• For H.264/AVC codec

Stream - <project file name>.bsf_imag - image
• For MPEG-2 codec

Stream - <project file name>.m2v_imag - image

z Hint

You can also select multiple video streams for 
registration.

Note

If an “UNDER FLOW” error occurs, reduce the bit rate and 
encode.
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Chapter 9 Result View

9-1 Chapter Outline

This chapter describes comparison viewing of source and 
encoded images.

For details on how to register clips for display in the Result 
View, refer to “6-4 Result View Registration,” page 88.

9-2 Starting and Quitting Result 
View

9-2-1 Starting Result View
Click the Result View button in the Launcher.

Result View starts.

9-2-2 Quitting Result View
Click the window’s  button.
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9-2-3 Result View Screen

a Prev/Next selectors

b Result View display area

Source and encoded images can be viewed split screen either 
vertically or horizontally, or by toggling full-screen views.
When viewed split screen vertically or horizontally, the 
images can be separated by a horizontal or vertical line, 
respectively.
When viewed full screen, source and encoded images are 
alternatively displayed.
Result View displays can be output as SDI/HDMI.

c Result View controls Other shortcut keys

a Prev/Next selectors

b Result View display area

c Result View controls

d Clip list show/hide button

e Clip list

f Time Code display
g Track bar

Button Description Shortcut key

Prev button
Displays the previously viewed clip.

Ctrl + P

Next button
Displays the next clip after viewing a 
previous clip with the Prev button.

Ctrl + N

Button Description Shortcut key

Horizontal button
Source and encoded images swap 
left and right positions with each 
press. The blue part of the button 
indicates the current position of the 
encoded image.

F5

Vertical button
Source and encoded images swap 
top and bottom positions with each 
press. The blue part of the button 
indicates the current position of the 
encoded image.

F6

Full-screen button
Source and encoded images are 
swapped with each press. The button 
is blue when the encoded image is 
displayed.

F7

Displays the Dynamic Splitter. F8

Moves to the start of a clip. Home

Displays the previous frame. F1

Play or stop. Space

Displays the next frame. F2

Moves to the end of a clip. End

Displays the timecode. Ctrl + T

Displays Time Code Search.
Specify and jump to a timecode.

Ctrl + J

Shortcut key Description

Ctrl + L Toggle the scene change line display ON/OFF.

Ctrl + T Move the scene change line left (fast).

Ctrl + t Move the scene change line right (fast).

Ctrl + R Move the scene change line up (fast).

Ctrl + r Move the scene change line down (fast).

Ctrl + Shift + T Move the scene change line left (one line).

Ctrl + Shift + t Move the scene change line right (one line).

Ctrl + Shift + R Move the scene change line up (one line).

Ctrl + Shift + r Move the scene change line down (one line).

Button Description Shortcut key
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d Clip list show/hide button

Displays or hides the clip list.

Shortcut keys

e Clip list

Displays registered content names and clips.

Select the clip to display in the viewing area according to 
content name, or from “My Recent Data.”
Press Enter or double click to display the selected clip to the 
clip display window.

Double click a clip in the clip display window to display it in 
the Result View area.
Click the Contents Display button or press Backspace to 
switch to the Contents Display.

Deleting clips: Select one or more clips, and press the Del 
key or select [Delete Clip] from the right-click menu.
Deleting contents: Select one or more contents, and press the 
Del key or select [Delete Content] from the right-click menu. 
When you delete contents, all clips that are included in the 
contents are deleted.
Sorting clips: By right-clicking during clip display, you can 
select [CreateTime (Ascending)] or [CreateTime 
(Descending)] in the menu to sort clips by creation date, or 
select [TimeCode (Ascending)] or [TimeCode 
(Descending)] to sort clips by timecode each angle unit.
Sorting contents: By right-clicking during content display, 
you can select [CreateTime (Ascending)] or [CreateTime 
(Descending)] in the menu to sort contents by creation date, 
or select [Name (Ascending)] or [Name (Descending)] to 
sort contents by name.

Click the Present Clip button to move the focus to the clip 
current displayed in the Result View area.

z Hint

My Recent Data is a folder that displays recently created 
clips.

f Time Code display

Click the Time Code button (Result View Control) to display 
the current timecode.

When source and encoded images are displayed split-screen 
horizontally, a vertical bar at the left or right of the timecode 
indicates the position of the encoded image. 

When source and encoded images are displayed split-screen 
vertically, a bar above or below the timecode indicates the 
position of the encoded image. 

With full-screen display, an underbar appears below the 
timecode when the encoded image is displayed.

g Track bar

Indicates the relative position of the displayed frame within 
the clip.
Point the mouse at the track bar and turn the mouse wheel to 
move forward and backward within the clip.

Shortcut key Description

Esc Hide the clip list.

Contents Display button
Present Clip button
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9-2-4 Dynamic Splitter Screen
Click the Dynamic Splitter button (Result View Control) to display.

a Show/hide divider

When viewing images split-screen horizontally or vertically, 
select or deselect this to show or hide the divider between 
images, respectively.

b Horizontal wipe bar

Move the slider to reposition the horizontal divider.
If horizontal split-screen is not currently active, moving the 
slider makes it active. 

c Horizontal Center button

Centers the divider in the horizontal split-screen display.

d Vertical Center button

Centers the divider in the vertical split-screen display.

e Vertical wipe bar

Move the slider to reposition the vertical divider.
If vertical split-screen is not currently active, moving the 
slider makes it active.

9-2-5 Time Code Search Screen
Click the Time Code Search button (Result View Control) to 
display.

Enter a timecode and click the [OK] button to move to the 
specified frame.

a Show/hide divider

b Horizontal wipe bar

c Horizontal Center button

d Vertical Center button

e Vertical wipe bar
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10-1 Scaling List

When the High Profile H.264/AVC codec is selected, 
encoding can be performed by specifying either a default or 
user-defined scaling list.
The H.264/AVC codec standard defines the following 
default scaling lists.

Default Scaling Lists
Y Intra 4 × 4, Cb Intra 4 × 4, Cr Intra 4 × 4: 

6, 13, 20, 28,

13, 20, 28, 32,

20, 28, 32, 37,

28, 32, 37, 42

Y Inter 4 × 4, Cb Inter 4 × 4, Cr Inter 4 × 4: 
10, 14, 20, 24,

14, 20, 24, 27,

20, 24, 27, 30,

24, 27, 30, 34

Y Intra 8 × 8: 
6, 10, 13, 16, 18, 23, 25, 27,

10, 11, 16, 18, 23, 25, 27, 29,

13, 16, 18, 23, 25, 27, 29, 31,

16, 18, 23, 25, 27, 29, 31, 33,

18, 23, 25, 27, 29, 31, 33, 36,

23, 25, 27, 29, 31, 33, 36, 38,

25, 27, 29, 31, 33, 36, 38, 40,

27, 29, 31, 33, 36, 38, 40, 42

Y Inter 8 × 8
9, 13, 15, 17, 19, 21, 22, 24,

13, 13, 17, 19, 21, 22, 24, 25,

15, 17, 19, 21, 22, 24, 25, 27,

17, 19, 21, 22, 24, 25, 27, 28,

19, 21, 22, 24, 25, 27, 28, 30,

21, 22, 24, 25, 27, 28, 30, 32,

22, 24, 25, 27, 28, 30, 32, 33,

24, 25, 27, 28, 30, 32, 33, 35

There are four types of luminance components: 4 × 4, 8 × 8, 
Intra, and Inter. There are also four types of color difference 
components: Cb, Cr, Intra, and Inter (as color difference 
components are only 4 × 4, no 8 × 8 component exists).

Values in the Scaling List can range from 1 to 255, with 
smaller values emphasizing the frequency component, and 
larger values suppressing the frequency component.

Fig. 10.1 shows the frequency components after 8 × 8 DCT. 
The top left element is the DC component, and others are AC 
components. Those elements toward the upper left are 
lower-frequency components, and those toward the bottom 
right are higher-frequency components, with the bottom 
right element being the highest-frequency component. 

Figure 10.1 Frequency components after 8 × 8 DCT 

Looking at the Default Scaling List, one can see that smaller 
values are specified for lower-frequency components, and 
larger values for higher-frequency components, 
corresponding to human visual characteristic that 
distinguishes differences in low-frequency components 
better than in high-frequency components.
As the above tendency is applicable to typical images, good 
image quality can be obtained by applying the Default 
Scaling List. However, some image content may have more 
low-frequency components, and other content may have 
more high-frequency components. For such content, better 
image quality may be obtained by favoring low- or high-
frequency components instead of using a Default Scaling 
List.
In addition, although the luminance and color difference 
values in the Scaling List are generally the same, you can 
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emphasize color difference image quality over luminance by 
providing smaller Scaling List values for color difference, 
resulting in more bandwidth being allocated to color 
difference information than to luminance (and vice-versa).

Similarly, the bilateral symmetry of the values in the Default 
Scaling List does not have to be maintained. Depending on 
the pattern of the content, there are cases where either 
horizontal or vertical components can be emphasized. In 
such cases, image quality may be improved by using values 
that favor treatment of particular components.
Because of the wide variations of content, there is no specific 
method to determine the optimum values for emphasizing or 
suppressing particular frequencies. The optimum values 
depend on the content to be processed.
However, low-frequency components tend to concentrate 
after DCT values. So attention should be paid where low-
frequency values change significantly, because generated 
values may be larger than expected. 
Furthermore, because image quality can be strongly 
affected, we recommend setting values experimentally with 
close observation of results.



106 10-2 Error Messages

Chapter 10 Other Information

10-2 Error Messages

10-2-1 Chapter

Code Message Solution

ER_1001 File Path Check error. Check the output destination.

ER_1002 VTR Status error.Initialization Fail. Check the connection to the VTR.

ER_1003 System Loading error. Check the system file.

ER_1004 Initialization error. Check the connections to the VTR and Capture Board.

ER_1005 Drop Frame Format Check error. Check the capture format.

ER_1006 Drop Frame Time Code Check error. Check the capture format.

ER_1007 FrameRate Check error. Check the capture format.

ER_1008 MaxFrame Check error. Check the capture format.

ER_1009 Capture file Path Check error. Check the capture file.

ER_1010 Audio file Path Check error. Check the audio file.

ER_1011 VTR Operate Status error. Check the connection to the VTR.

ER_1012 VTR Play error. Check the connection to the VTR.

ER_1013 VTR Pause error. Check the connection to the VTR.

ER_1014 VTR StanbyOff error. Check the connection to the VTR.

ER_1015 VTR StanbyOn error. Check the connection to the VTR.

ER_1016 Time Code Format Change error. Check the connection to the VTR.

ER_1017 VTR Jump error. Check the connection to the VTR.

ER_1018 VTR Jump Start error. Check the connection to the VTR.

ER_1019 VTR Eject error. Check the connection to the VTR.

ER_1020 VTR Rewind error. Check the connection to the VTR.

ER_1021 VTR StepBackward error. Check the connection to the VTR.

ER_1022 VTR StepForward error. Check the connection to the VTR.

ER_1023 VTR PlaySpeed Change error. Check the connection to the VTR.

ER_1024 Auto Eject error. Check the connection to the VTR.

ER_1025 Disk Space Check error. Check the capacity of the storage location.

ER_1026 Capture error. Start the application again.

ER_1027 Capture Stop error. Start the application again.

ER_1028 VTR Stop error. Check the connection to the VTR.

ER_1029 Batch Capture error Detect. Start the application again.

ER_1030 Batch Capture Prepare error. Start the application again.

ER_1031 Batch Capture Start error. Start the application again.

ER_1032 TimeCode Check Timer error. Check the capture format.

ER_1033 VTR DropFrame Check error. Check the connection to the VTR.

ER_1034 Get VTR Status Code Get error. Check the connection to the VTR.

ER_1035 VTR Cassette Status error. Check the connection to the VTR.

ER_1036 VTR Standby Status error. Check the connection to the VTR.

ER_1037 Set PrerollTime error. Check the connection to the VTR.

ER_1038 Device Close error. Check the connections to the VTR and Capture Board.

ER_1039 System Closing error. Start the application again.
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10-2-2 Preprocess

10-2-3 Encode

Code Message Solution

ER_2001 PPM SceneChangeFilter Filter error. Check the source file, and start the application again.

ER_2002 PPM InvsersePulldown Filter error. Check the source file, and start the application again.

ER_2003 Direct Show Filter error. Check the source file, and start the application again.

Code (hex) Message Solution

0xF3310001 Encode batch process error Check the source file, and start the application again.

0xF3110001 Encode batch process error Check the source file, and start the application again.

0xF3110002 Encode batch process error Check the source file, and start the application again.

0xF3110003 Encode batch process error Check the source file, and start the application again.

0x73010002 Encode batch process error Check the source file, and start the application again.

0x73010005 Encode batch process error Check the source file, and start the application again.

0xF3320001 Encode PC error. Check the source file, and start the application again.

0xF3120001 Encode PC error. Check the source file, and start the application again.

0xF3320003 Encode PC error. Check the source file, and start the application again.

0x73020001 Encode PC error. Check the source file, and start the application again.

0xF3350006 Encode process error. Check the source file, and start the application again.

0xF3350003 Encode process error. Check the source file, and start the application again.

0xF3350007 Encode process error. Check the source file, and start the application again.

0xF3050003 Encode process error. Check the source file, and start the application again.

0xF3360001 Encode process error. Check the source file, and start the application again.

0xF3360003 Encode process error. Check the source file, and start the application again.

0xF4313009 file not found : Venc.xml Check the source file, and start the application again.

0xF4111001 file access error : Venv.cml Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4212003 file access error : Venv.cml Check the file format and version, and then try again.

0xF4313001 System error Check the source file, and start the application again.

0xF4333001 System error Check the source file, and start the application again.

0xF4131001 file access error : Sinf.xml Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4343001 System error Check the source file, and start the application again.

0xF4141001 file access error : Pulldown pattern file. Check the source file, and start the application again.

0xF4141002 file access error : Pulldown pattern file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4141003 file access error : Pulldown pattern file. The file may be corrupted, or the file format specified is not correct.

0xF4242001 file access error : Pulldown pattern file. Check the source file, and start the application again.

0xF4242002 file access error : Pulldown pattern file. Check the file format and version, and then try again.

0xF4343003 file access error : Pulldown pattern file. The file does not contain pattern data. Please try again.

0xF4343002 file access error : Pulldown pattern file. The file does not contain pattern data. Please try again.

0xF4348001 file access error : Pulldown pattern file. The file does not contain pattern data. Please try again.

0xF4348002 file access error : Pulldown pattern file. The file does not contain pattern data. Please try again.

0xF4348003 System error Check the source file, and start the application again.
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0xF4348004 System error Check the source file, and start the application again.

0xF4353001 System error Check the source file, and start the application again.

0xF4151001 file access error : Scene Change file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4151002 file access error : Scene Change file. The file may be corrupted, or the file format specified is not correct.

0xF4151003 file access error : Scene Change file. The file may be corrupted, or the file format specified is not correct.

0xF4252001 file access error : Scene Change file. Check the file format and version, and then try again.

0xF4252002 file access error : Scene Change file. The file does not contain pattern data. Please try again.

0xF4353003 System error Check the source file, and start the application again.

0xF4353002 System error Check the source file, and start the application again.

0xF4363001 System error Check the source file, and start the application again.

0xF4161001 file access error : EncInfo.bin Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4161002 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4161003 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4262001 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4363002 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4363003 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF436C001 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4365001 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4365002 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4365003 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF4264001 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4264002 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4264003 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4264004 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4264005 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4363009 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4161004 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF43E3002 file access error : EncInfo.bin The file may be corrupted, or the file format specified is not correct.

0xF41E1001 file access error : Picture report file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41E1002 file access error : Picture report file. The file may be corrupted, or the file format specified is not correct.

0xF42E2001 file access error : Picture report file. The file may be corrupted, or the file format specified is not correct.

0x74060001 file access error : EncInfo.bin Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4373001 System error Check the source file, and start the application again.

0xF4171001 file access error : SegmentInfo file Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4171002 file access error : SegmentInfo file The file may be corrupted, or the file format specified is not correct.

Code (hex) Message Solution



10-2 Error Messages 109

C
h

ap
ter 10

0xF4171003 file access error : SegmentInfo file Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4272001 file access error : SegmentInfo file Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4373002 System error Check the source file, and start the application again.

0xF4373003 System error Check the source file, and start the application again.

0xF4272002 System error Check the source file, and start the application again.

0xF4373009 System error Check the source file, and start the application again.

0x74070001 System error Check the source file, and start the application again.

0x74070002 System error Check the source file, and start the application again.

0x74070003 System error Check the source file, and start the application again.

0xF4393001 System error Check the source file, and start the application again.

0xF4191001 file access error :CsInfo file Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF4191002 file access error :CsInfo file The file may be corrupted, or the file format specified is not correct.

0xF4191003 file access error :CsInfo file The file may be corrupted, or the file format specified is not correct.

0xF4292001 System error Check the source file, and start the application again.

0xF4393002 System error Check the source file, and start the application again.

0xF4393003 System error Check the source file, and start the application again.

0xF4393009 System error Check the source file, and start the application again.

0x74090001 System error Check the source file, and start the application again.

0xF43A3001 System error Check the source file, and start the application again.

0xF41A1001 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41A1002 file access error : User Scaling List file. The file may be corrupted, or the file format specified is not correct.

0xF41A1003 file access error : User Scaling List file. The file may be corrupted, or the file format specified is not correct.

0xF42A2001 file access error : User Scaling List file. The file may be corrupted, or the file format specified is not correct.

0xF43A3003 System error Check the source file, and start the application again.

0xF41A1005 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41A1006 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41A1007 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41A1008 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41A1009 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41A1004 file access error : User Scaling List file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF42A2002 System error Check the source file, and start the application again.

0x740A0001 System error Check the source file, and start the application again.

0xF43B3001 System error Check the source file, and start the application again.

0xF41B1001 file access error : User QMatrix file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41B1002 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

Code (hex) Message Solution
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0xF41B1003 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF42B2001 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF43B3003 System error Check the source file, and start the application again.

0xF41B1005 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF41B1006 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF41B1007 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF41B1008 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF41B1009 System error Check the source file, and start the application again.

0xF41B1004 file access error : User QMatrix file. The file may be corrupted, or the file format specified is not correct.

0xF42B2002 System error Check the source file, and start the application again.

0x740B0002 System error Check the source file, and start the application again.

0xF41C1001 file access error : Stp file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41C1002 file access error : Stp file. The file may be corrupted, or the file format specified is not correct.

0xF41C1003 file access error : Stp file. The file may be corrupted, or the file format specified is not correct.

0xF43C3009 file access error : Stp file. The file may be corrupted, or the file format specified is not correct.

0xF43C3003 file access error : Stp file. The file may be corrupted, or the file format specified is not correct.

0xF41C1004 file access error : Stp file. The file may be corrupted, or the file format specified is not correct.

0xF43D3001 System error Check the source file, and start the application again.

0xF41D1001 file access error : Hinstory Info file. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF41D1002 file access error : Hinstory Info file. The file may be corrupted, or the file format specified is not correct.

0xF41D1003 file access error : Hinstory Info file. The file may be corrupted, or the file format specified is not correct.

0xF42D2001 file access error : Hinstory Info file. The file may be corrupted, or the file format specified is not correct.

0xF43D3003 System error Check the source file, and start the application again.

0xF41D1004 file access error : Hinstory Info file. The file may be corrupted, or the file format specified is not correct.

0xF42D2002 System error Check the source file, and start the application again.

0xF41D100A System error Check the source file, and start the application again.

Code (hex) Message Solution
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Code (hex) Message Solution

0xF3370001 Finalize process error. Check the stream file, and start the application again.

0xF3170006 Finalize process file access error. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF3370003 Finalize process error. Check the stream file, and start the application again.

0xF3170014 Finalize process error. Check the stream file, and start the application again.

0xF3370002 Finalize process error. Check the stream file, and start the application again.

0xF3170009 Finalize process file access error. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF3170007 Finalize process file access error. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF3170008 Finalize process file access error. Check properties such as the connection to storage, exclusive 
controls, and access permissions.

0xF3180001 Finalize process error. Check the stream file, and start the application again.

0xF3180006 Finalize process error. Check the stream file, and start the application again.

0xF3280004 Finalize process error. Check the stream file, and start the application again.

0xF3280005 Finalize process error. Check the stream file, and start the application again.

0xF3280006 Finalize process error. Check the stream file, and start the application again.
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Chapter 10 Other Information

The material contained in this manual consists of 
information that is the property of Sony Corporation and is
intended solely for use by the purchasers of the equipment 
described in this manual.
Sony Corporation expressly prohibits the duplication of any 
portion of this manual or the use thereof for any purpose 
other than the operation or maintenance of the equipment 
described in this manual without the express written 
permission of Sony Corporation.

Le materiel contenu dans ce manuel consiste en informations 
qui sont la propriete de Sony Corporation et sont destinees 
exclusivement a l’usage des acquereurs de l’equipement 
decrit dans ce manuel.
Sony Corporation interdit formellement la copie de quelque 
partie que ce soit de ce manuel ou son emploi pour tout autre 
but que des operations ou entretiens de l’equipement a moins 
d’une permission ecrite de Sony Corporation.
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